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Experience the Entertainment Fun
Microsoft® Windows® XP Media Center Edition 2005 lets 
you do amazing things with your HP Digital Entertainment 
Center. With a full range of easy-to-use digital 
entertainment features, you can experience TV, movies, 
music, and photos like never before.

Media Center is simple and easy to use. You can easily 
find and choose your media. You can play movies, listen 
to music, view photos, and watch TV with a single remote 
control. Combine the powerful features of your HP Digital 
Entertainment Center with a home theater receiver to 
enjoy an even more dynamic entertainment experience.

Watch and record live TV
With Media Center you can pause, advance frame by 
frame, skip ahead, or use instant replay to catch every 
moment of live TV. Use fast-forward to bypass unwanted 
content. When you are not able to watch your favorite 
show, you can use Media Center to record it.

Record TV with ease by using the Television Program 
Guide to select the shows you want to record. You can 
record one show or an entire series and watch it when it 
is convenient for you. You will never miss a moment of 
your favorite shows.

The right music for the 
moment
Browse your entire music library by artist, genre, and 
song. Select a playlist or a single album, or do a random 
shuffle from your music collection. You can even play 
songs from your iTunes music Library.

Share your digital memories
Create personalized slide shows with music for viewing 
on your TV. Easily edit and create professional-looking 
home videos from the comfort of your couch with the 
remote control.

Transform your living space into a theater
Whether you are watching a DVD movie or your own 
home videos, Media Center delivers a rich viewing 
experience with a high-quality digital sound system. 
Sit back and enjoy the show.
Welcome 1



Using Media Center Features
You can control the Media Center functions and navigate 
Media Center windows by using the remote control, the 
keyboard, or the trackball. You can easily switch back 
and forth between them by moving the trackball or by 
pressing a button on the remote control or the keyboard.

You can run Media Center side-by-side with other 
Windows software programs. It’s possible to browse 
through your pictures, watch videos, play music, and 
even record TV while using other Windows programs.

When using the remote control and the Media Center 
program, you can:

■ Watch, record, and play back television programs 
on any TV in the house.

■ Pause, rewind, and fast-forward TV programs.
■ Watch an instant replay.
■ Play back your digital videos.
■ View your digital pictures or play them as a slide 

show with music. Easily print your photos.
■ Browse, select, and play music CD files with 

full-screen visualizations.
■ Record CD tracks to your media library.
■ Play DVD movies. Resume playing your DVDs where 

you left off.
■ Listen to FM radio stations.
■ Access streaming music and video subscription 

services. Some music and video subscription services 
may not be available in all countries/regions.

■ Record your TV shows automatically while you are 
doing something else.

■ Open specific windows in Media Center by using 
the shortcut buttons on the remote control.

■ Communicate with your friends and family by using 
instant messaging. Instant messaging may not be 
supported in all countries/regions.

■ Enjoy Media Center remotely (select models only).
■ Easily back up your media files to CD, DVD, or 

another hard disk drive such as the HP Personal 
Media Drive.

n
If your HP Digital Entertainment Center came 
with a rewritable DVD drive, the drive is able 
to read and record to both DVD+R/RW and 
DVD-R/RW media.

n
Some of the Media Center features listed are 
for select models only.

Some of the components listed in the HP 
Digital Entertainment Center documentation, 
such as speakers, are optional and sold 
separately.

n
The Television Program Guide may not be 
available in all countries/regions.
2 Microsoft Windows XP Media Center Edition 2005 Software Guide
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Setting Up Media Center

The first time you start your HP Digital Entertainment 
Center, a Media Center setup wizard opens. It is 
recommended to complete each step in the Media Center 
setup wizard to be able to use all the features in Media 

Center. The Media Center setup wizard may take 
approximately 10 to 40 minutes to complete. If there are 
steps you still need to complete, you can go to the 
Settings menu by following the procedure below.

Completing the setup wizard steps 

1 Press the Media Center Start button  on the 
remote control.

2 Select Settings. You may need to use the arrow 
buttons on the remote control to scroll down to see all 
the menu items. 

3 Select General, Media Center Setup, and then 
select Run Media Center Setup Again. Follow the 
onscreen instructions to complete the wizard.

n
For the latest information about setting up 
your HP Digital Entertainment Center, refer to 
the setup poster.
Using Media Center 3



Listed below are some of the items included in the setup 
wizard:

■ Check for your Internet connection. An 
Internet connection allows Media Center to 
download and update your Television Program 
Guide and display information about your music 
CDs and other media.

■ Configure your TV tuner, TV signal source, 
and Television Program Guide. You need to 
provide information about your TV signal source and 
your TV signal equipment (set-top box, cables, and 
so on). This step makes sure your HP Digital 
Entertainment Center receives the correct TV signal 
and Television Program Guide information. If you 
have a cable box or satellite receiver, the setup 
wizard programs your remote control to work 
with them.

■ Optimize how Media Center looks on your 
display. You can change display settings such as 
brightness, contrast, RGB color, and centering.

■ Set up your speakers. Select how many 
speakers you have and test them.

n
You must subscribe with an Internet Service 
Provider (ISP) to have an Internet connection.

n
You can change your Media Center settings in 
the Settings menu.
4 Microsoft Windows XP Media Center Edition 2005 Software Guide
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Media Center Start Menu

A Access a menu to exit Media Center, to shut 
down or to restart the HP Digital 
Entertainment Center, to log off to end your 
Media Center session, to put the HP Digital 
Entertainment Center into standby mode, or 
to switch users

B Use media playback controls: Play, Stop, 
Pause, Skip, Fast-Forward, Replay, Rewind, 
Record, Volume Up/Down, and Channel 
Up/Down

C Open the Media Center Start menu

D Go back one screen

E Open the Media Center Help

F Minimize the Media Center window

G Resize the Media Center window

H Close the Media Center window

J Go to the Media Center Web site for the 
latest Media Center information

K Watch your home videos

L View digital pictures or play a slide show; 
print photos

M Watch, record, and play back TV programs

N Play music files or music CDs, create and 
edit playlists, and record music files to CD

O Play FM radio stations

P Find utilities and programs: instant 
messaging, video editing, and creating 
CDs/DVDs

C D E F G

H

J

K

M

L

N
O

P

B

A

n
Some of the features listed are for select 
models only.
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Other menus not shown:

■ HP Image Zone — View digital pictures, play a 
slide show, and print photos

■ HP Tunes — Play music from your iTunes music 
Library or from music CDs

■ Play DVD — Watch DVD movies
■ Settings — Change Media Center program settings

Online Spotlight
Online Spotlight is a link to the Microsoft Web site, where 
you can find the latest Media Center information and 
media offers and services. This site is periodically 
updated by Microsoft. Some of the services listed may not 
be available in some countries/regions.

Your HP Digital Entertainment Center must be connected 
to the Internet to access the Online Spotlight Web site.

Navigating Media Center
In the Media Center windows, a selected item such as a 
folder, file, or menu item is outlined with a green border.

You can control the Media Center functions and navigate 
Media Center windows by using the remote control, the 
keyboard, or a trackball.

To select items in Media Center by using the remote 
control, use the arrow buttons on the remote control, and 
then use the OK button to enter your selection.

If you have media playing, such as music or television, it 
appears in an inset window in the lower-left corner. To 
switch from watching your media in the inset window to 
watching it in full-screen mode, use the arrows on the 
remote control to select it, and then press OK.

.
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Media Center menu bars
When you move the trackball, the Media Center menu 
bars appear. These menu bars allow you to access media 
controls, Media Center Help, the back screen arrow, 
window control icons and the Media Center icon that 
takes you to the main Media Center menu. When you use 
the remote control, or when you stop using the trackball 
(after 5 seconds), the menu bars disappear.

Media Center control menu
To access the control menu in Media Center, 
move the trackball to display the menu bars. 
Select the Shut Down icon on the main Media 

Center window.

From this control menu, you can select icons to perform 
various actions.

n
You can use the Minimize and Resize buttons 
to switch to the desktop or to run Media 
Center side-by-side with another program.

Icon Action

Log off and end your 
Media Center session 
and switch users

Shut down the HP 
Digital Entertainment 
Center

Restart the HP Digital 
Entertainment Center

Put the HP Digital 
Entertainment Center in 
a reduced power state 
— standby mode
Using Media Center 7



Using Instant Messaging in Media Center
Instant messaging may not be supported in all countries/
regions.

Media Center supports instant messaging so you can 
communicate with your friends and family while you are 
doing something in Media Center. You always have the 
option to turn this feature on or off.

You can use your remote control to log in and type 
messages. You can even have multiple conversations.

Logging in to your messenger account

1 First, you must go to http://www.msn.com to set 
up your messenger account. You will need a .NET 
passport to log in to messenger. A .NET passport is 
an e-mail address, a login name, and a password. 
Make sure you verify the account with MSN before 
you try to log in from Media Center.

2 Press the Media Center Start button  on the 
remote control to open Media Center.

3 Select More Programs, and then 
select the Messenger icon.

4 Select Sign In.

5 Enter your .NET passport information, and then 
select Sign In.

n
From most areas in Media Center, you can 
press Ctrl + D on the keyboard, or select a 
media file and press the More Info button on 
the remote control to access the Messenger 
login screen.
8 Microsoft Windows XP Media Center Edition 2005 Software Guide
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Changing Media Center Settings
In the Media Center Settings window, you can change 
settings for watching television, for viewing your pictures 
and slide shows, and for controlling sound and the 
display of all the Media Center windows.

To change your Media Center settings:

1 Press the Media Center Start button  on the 
remote control.

2 Select Settings.

3 Select a category.

4 Select one of the settings listed. Then, use the arrow 
buttons to select an option or follow the onscreen 
instructions.

5 Select Save to save your changes.

Media Center Settings categories
■ TV to set up TV signal, audio, and closed 

captioning. You can download or edit the Television 
Program Guide, view or clear recording history, set 
hard disk drive recorder storage space, configure 
your display, and set recording defaults.

■ Pictures to set slide-show settings.
■ Music to select visualizations or song information to 

display when playing a song.
■ DVDs to select a language for subtitles, audio 

tracks, and menus of your DVDs, program the remote 
control buttons for your DVDs, and select closed 
captioning. You can also access audio settings for 
your speakers. You must use a trackball or keyboard 
to select the audio settings.

■ Messenger and Caller ID to allow instant 
messages within Media Center and set notifications 
for caller ID. Instant Messaging may not be 
supported in all countries/regions.

■ Radio to organize or delete pre-set radio stations.

n
Some settings, such as parental control 
and caption display settings for TV and DVDs, 
are included with select models only. Not all 
channels support closed captioning.
Using Media Center 9



■ General to set:
■ Startup and Window behavior.
■ Visual and Sound Effects to set transition 

animations and sounds when navigating in 
Media Center.

■ More Programs Options to change settings 
for other programs on the HP Digital 
Entertainment Center.

■ Media Center Setup to configure your Internet 
connection, TV signal, speakers, TV, or monitor; 
access Windows updates; run Media Center 
setup again; set up remote desktop; and reset 
Start Page defaults.

■ Parental controls to block unwanted TV 
channels and block unwanted TV and movie 
ratings, change access code, and reset parental 
controls.

■ Automatic Downloads Options to get 
media information about CDs, DVDs, and movies 
from the Internet and to select how to download 
the Television Program Guide.

■ Help to find help about using Media Center and 
your hardware.

Changing audio, video, display resolution, and other settings
To change your audio and video settings:

1 Press the Media Center Start button  on the 
remote control.

2 Select More Programs.

3 Select HP Settings.

4 Select one of the following settings:

■ DVD to adjust audio and video settings for DVD 
playback using InterVideo WinDVD player.

■ Resolution to adjust the appearance of 
Windows Desktop for your TV.

■ Front Panel to adjust the brightness of the front 
panel display on the HP Digital Entertainment 
Center.

■ HP Media Drive to set up your HP Personal 
Media Drive to access music, pictures, videos, 
and recorded TV shows from within HP Media 
Center.

5 Use the arrow buttons to select an option or follow 
the onscreen instructions.
10 Microsoft Windows XP Media Center Edition 2005 Software Guide
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Changing the display resolution
The desktop display resolution utility changes the viewing 
experience outside of Media Center. Use this if you have 
trouble reading programs running from the Windows 
Desktop. Some programs may not work with the lower 
resolution recommended for standard definition TVs.

1 Press the Media Center Start button  on the 
remote control.

2 Select More Programs, and then select 
HP Settings.

3 Select Resolution, and then select OK.

4 Select a resolution that is recommended for your type 
of display, and then select Apply.

Or

Select the Advanced button to open the display 
properties control panel where you can select the 
Settings tab, and then select another resolution 
setting by moving the slider bar under Screen 
resolution. Select OK.

Contacting HP Support in Media Center
You can access a link to HP Support in Media Center by 
using your remote control. At HP Support you can:

■ Register your product with HP.
■ Learn more about your HP Digital Entertainment 

Center and Media Center.
■ Test your hardware with interactive diagnostic 

software.
■ Connect to online technical support or access a 

telephone number to talk with a technical support 
agent.

1 Press the Media Center Start button  on the 
remote control.

2 Select More Programs, HP Settings, and then 
select HP Support.

3 Select an option, and then follow onscreen 
instructions. You need to use your trackball and 
keyboard in this Web site.

n
Resolution settings:

1024 x 768 is recommended for high 
definition TVs.

800 x 600 is recommended for standard 
definition TVs larger than 32".

640 x 480 is recommended for standard 
definition TVs smaller than 32".

n
HP Support is available 24 hours per day, 
7 days per week, 365 days per year.
Using Media Center 11



Finding Additional Media Center 
Information

To learn more about using Media Center, refer 
to the online and other Help files located in 
Media Center. Using your trackball, click the 
Help icon in the Media Center toolbar.

You can select Online Spotlight from the main Media 
Center menu to go online for the latest Media Center tips 
and other information. Online Spotlight may not be 
available in all countries/regions.

Also, you can access the Microsoft Windows XP Media 
Center Edition 2005 Reference Guide when you go 
online to the HP Support Web site at:

http://www.hp.com/support 

To find the online documentation for your product, search 
for your model number and then click Manuals.
12 Microsoft Windows XP Media Center Edition 2005 Software Guide
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The remote control is designed to work with Media Center. 

You can use your remote control with Media Center to play 
CDs and DVDs, to view pictures, and to watch and record 
television programs.

This remote control helps you navigate the Media Center 
windows on your computer just as a TV remote control helps 
you navigate cable TV options or control the playback of a 
movie in a VCR or DVD player.

The remote control can:
■ Navigate and control all Media Center windows.
■ Control the video or live TV display.
■ Place the computer in and out of standby mode.
■ Shut down or restart the HP Digital Entertainment 

Center.
■ Log off from Media Center or switch users.
■ Access Teletext menus while watching live TV.

The remote control cannot:
■ Navigate the Windows desktop or control other 

computer programs outside of Media Center.
■ Be used as a VCR, DVD player, or stereo remote 

control.
■ Turn on or off a TV that is connected to your HP Digital 

Entertainment Center.
■ Turn on the HP Digital Entertainment Center.

n
The remote control operates up to 7.9 meters 
(26 feet) away from the remote sensor.

Make sure there is nothing blocking the 
pathway between your remote control and 
the remote sensor.
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Remote Control Buttons Overview
Features and location may vary

A Standby  puts the HP Digital Entertainment Center 
into and out of a power-reduced state.

B DVD Menu opens the Play DVD window or opens the 
main menu of a DVD movie, if available.

C The green button opens a Teletext menu while 
watching live TV.

D The red button opens a Teletext menu while watching 
live TV.

E Record records a selected television program and 
stores it on the hard disk drive when in Live TV mode. 
The Record button is inactive for all other media.

F Rew (Rewind) moves the media backward at two 
speeds.

G Replay moves media backward 7 seconds.

H Pause pauses audio and video tracks and live or 
recorded TV programs.

J Back returns HP Digital Entertainment Center to the 
previous window within Media Center.

K Arrow buttons move the cursor to navigate and select 
actions within all Media Center windows.

L Start opens Media Center to the main Start menu.

M Volume increases (+) and decreases (–) volume.

N Live TV is a shortcut to the full-screen view of live TV. 
Moves a TV program forward to the end of the pause 
buffer and resumes playing live TV.

O Guide opens the Television Program Guide.

P Clear deletes the last character entered.

321

654

987

JKL

TELETEXT

STOP

FWD

MORE

SKIP

CH/PG

DVD MENU

RECORDED TV

PLAY

PAUSE

REW

RECORD

REPLAY

VOLUME

LIVE TV

BACK

DEF

WXYZ

MNO

ABC

TUV

GHI

PQRS

MUTE

GUIDE

CLEAR ENTERPRINT

#* 0

OK

A

B

C

D

E

F

G

H
J

K

N

L

M

O

P

Q
R

S
T

U

V

W

X

Y

Z

AA

BB

DD
EE

CC
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mode. The Teletext page either replaces the live TV 
picture or is displayed over it. TV sound is still 
available.

R The yellow button opens a Teletext menu while 
watching live TV.

S The blue button opens a Teletext menu while 
watching live TV.

T Play plays the selected media.

U Stop stops the media currently playing.

V Fwd (Fast-forward) moves media forward at 
three speeds.

W Skip moves media forward — for example, 
30 seconds in videos and live TV or one music track.

X More (i) displays available information about a 
selected media file and displays other menus.

Y OK selects the desired action or window option and 
acts as the Enter key.

Z CH/PG up (+) and down (–) changes the TV 
channels or moves pages up and down, depending 
on available options. Moves to the next DVD 
chapter.

AA Mute turns computer sound off. The word Mute is 
displayed when Mute is turned on.

BB Recorded TV opens the Recorded TV window 
where recorded TV programs are listed.

CC 0 to 9, #, * are the numeric keypad buttons to 
change channels or enter text into a Media Center 
search or text box. Each time you press a number 
button, a different character appears. Press the Enter 
button to select a character.

DD Enter selects the desired action, menu, or window 
option.

EE Print prints your pictures that you select in the My 
Pictures window of Media Center.

w
If you turn off (shut down) your HP Digital 
Entertainment Center, Media Center will not 
record a scheduled TV program. The HP 
Digital Entertainment Center must be turned 
on or in standby mode to record TV 
programs.

n
Make sure you turn off the monitor and turn 
down or mute the volume; for example, if 
you have a scheduled recording in the middle 
of the night and don’t want to be disturbed.

The HP Digital Entertainment Center will not 
automatically go into standby mode if Media 
Center is open. It is recommended to close 
Media Center before you manually place 
the HP Digital Entertainment Center in 
standby mode.
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Teletext access buttons
(Select models only)

Although Teletext is broadcast free of charge, your TV set 
must be equipped with a Teletext decoder. Access to 
Teletext and all of its functions is available through your TV 
and the Media Center remote control.

Although the following information should describe the 
operation of Teletext for most TV sets, functions vary 
between manufacturers and models. For specific 
information about your particular TV model, please see 
the documentation that came with your TV.

Teletext consists of pages of free information such as 
news, sports, financial information, recipes, entertainment 
listings, holiday advertisements, music and TV reviews, 
backup information for certain TV programs, and themes 
for television sets capable of viewing these pages. 

The actual Teletext pages are broadcast in a hidden part 
of the television signal and decoded by the television. 
Teletext pages are accessed by a three-figure number; on 
most channels, the front page is on page 100.

The Teletext access buttons listed below open the main 
Teletext pages. Each Teletext page has a unique three-
digit page number. All pages can be accessed by typing 
in the number using the numeric keypad on the remote 
control.

Use the up and down arrows to navigate through the 
different Teletext pages.

Button Function

Teletext 
(Text)

Toggle button to turn Teletext on and off. This button opens page 100, or the home page. The 
Teletext page completely replaces the TV or Media Center display; however, sound is still 
available. To return to the TV or Media Center display, press this button again. On some 
displays, Teletext can be viewed over the display picture.

Red Opens the red Fasttext shortcut link when display is in Teletext mode.

Green Opens the green Fasttext shortcut link when display is in Teletext mode.

Yellow Opens the yellow Fasttext shortcut link when display is in Teletext mode.

Blue Opens the blue Fasttext shortcut link when display is in Teletext mode.
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Watch live TV or record your favorite shows for later 
playback. Use the Television Program Guide to find the 
show you want to watch or record. You can also record a 
show while watching another prerecorded show.

Navigating My TV
From the My TV window you can search for and play 
your favorite TV shows. Use the following menu items to 
help you locate what you want to do:

■ Live TV: Watch, pause, fast-forward, or rewind your 
favorite TV shows. You can watch recorded TV shows 
while recording another show. Use the More 
information button on the remote control to display 
TV show information.

■ Recorded TV: View a list of recorded programs by 
date or title, view a list of programs scheduled to be 
recorded, play a recorded program, find out why a 
program wasn’t recorded, or add a TV recording 
manually.

■ Search: Quickly find a TV program or a series to 
watch or record by entering a descriptive word, 
program title, or program category.

■ Guide: (Not available in all countries/regions.) 
Scroll through the Television Program Guide to find 
programs to watch and record. You can record 
specific TV shows or a whole series to your hard disk 
drive or an HP Personal Media Drive.

■ Movies: Go online to find movies to watch now or 
later. Get the latest information about movies on TV: 
read reviews, see cast lists, find other times the movie 
is broadcast, view the DVD cover, browse for related 
movies, and find other movies with the same cast 
members. 

n
Digital video recording features and the 
Television Program Guide are for select 
models only.

n
The Movies online information feature is 
available for some countries/regions.
Watching and Recording TV Programs 17



Watching TV
Before you can watch TV by using Media Center, 
make sure:

■ The computer is set up correctly for your TV signal 
source. Refer to the setup poster and the HP Digital 
Entertainment Center User’s Guide for more 
information.

■ You have completed the Media Center setup wizard. 
If you have not completed the setup wizard, refer to 
“Completing the setup wizard steps” on page 3.

n
You can change the channel by using the 
remote control while in full-screen mode or 
when the inset window is selected.

You can go to live TV from anywhere in 
Windows Media Center by pressing Live TV 
on the remote control.

While in the Guide, you can select a channel 
to see upcoming programs for that channel, 
by pressing the arrow buttons on the remote 
control.
18 Microsoft Windows XP Media Center Edition 2005 Software Guide
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Watching Live TV

1 Press the TV button on the remote control or select 
My TV from the main start menu. Use the arrow 
buttons on the remote control to select Live TV, and 
then press OK. The last channel selected or the first 
channel available begins playing.

2 Select a channel by using the CH/PG (+) or (–) 
buttons or the numeric keypad on the remote control, 
and then press OK on the remote control. The 
channel number and program information are 
displayed in the window.

3 Press the More information button to open 
another menu with the following options and 
information: 

■ A zoom option.
■ Access to Messenger and Settings windows.
■ Program information such as channel number 

and station, title and time period of program, 
actual time, and a brief summary of the program 
and TV rating, if available. Recording options 
are also shown.

4 To exit full-screen mode and return to the previous 
window, press Back on the remote control.

i
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Controlling TV playback
The personal video recorder functionality lets you record 
single shows or capture entire series for later viewing.

When you open the My TV window and begin watching 
live TV, Media Center automatically begins recording the 
selected program in the background for up to 30 minutes. 
When you pause a live TV program while watching in 
full-screen mode, the time-shifting window appears. To 
record a program longer than the 30 minutes, you must 
select to record the program.

You can return to the live broadcast by pressing the Live 
TV button on the remote control.

When you change the channel, Media Center deletes the 
previously recorded portion and begins recording again 
after a short delay.

n
The 30-minute pause buffer applies 
only when pausing, rewinding, and 
fast-forwarding live TV. Media Center 
allows you to record a program for 
longer than 30 minutes when you select to 
record the program.

n
You cannot pause a live TV program and then 
rewind to the beginning of the pause buffer 
and then begin recording. You can record a 
TV program only from live TV.

n
The digital video recording features are for 
select models only.
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Using the remote control in My TV

 Button Action

To freeze the live TV image, press Pause. While paused, My TV continues to record a pause 
buffer for up to 30 minutes. To resume watching TV where you left off, press Play.

To stop live TV or a recorded program, press Stop once. To resume watching the program, 
press Play.

To move forward in a live TV program that has been paused, or in a recorded program, press 
Fast-Forward (Fwd). To speed up the fast-forwarding, press Fwd two or three times. Fwd allows 
you to skip 3 hours in the Television Program Guide.

To play a recorded TV program or to resume watching a program after pressing the Pause, 
Fast-Forward, Rewind, Replay, or Skip buttons, press Play.

To advance in live TV or in a recorded program by 30 seconds, press Skip once. You can 
repeatedly skip forward, but only to the end of the pause buffer or the recorded program. 
Allows you to skip 12 hours in the Guide.

To move backward in live TV or a recorded program, press Rewind (Rew). To speed up 
rewinding, press Rew three times. To resume watching the program, press Play. Rew allows 
you to move back 3 hours in the Guide.

To move backward in live TV by 7 seconds, press Replay. You can repeatedly rewind with the 
instant replay option, but only to the beginning of the pause buffer or recorded program. 
Allows you to move back 12 hours in the Guide.

Live TV (TV) To maximize the TV viewing window to full-screen mode, press Live TV. Also, to advance to the 
end of the pause buffer and resume watching the live TV broadcast, press Live TV.

More 
information

To see the channel number, station identifier, title of program, time slot, and category of 
program, press the More information button while in full-screen mode. If you select a recorded 
show and then press the More information button, you can access more information about a 
program, stop or delete a program, record a series, change the “Keep Until” setting, copy a 
selected program to CD/DVD, access the instant messaging dialog box, and access TV 
settings.

CH/PG To move to the next channel or page in the Television Program Guide, press the CH/PG (+) 
and (–) buttons.

Guide To open the Television Program Guide, press Guide. When in the Guide window, press Guide 
again to view a program categories menu. To filter your Guide to display only programs in a 
category, you can select a category, such as Drama.

i
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Using the Television Program Guide
The Television Program Guide is a service contracted by 
Microsoft that provides TV listings information, such as 
channel, network, program title, summary, and scheduled 
broadcast times. This service is currently not available in 
some countries/regions.

In countries/regions where the Guide is not available, 
please refer to “Using Media Center without a Guide” on 
page 22 and see “Recording programs manually with or 
without a Guide” on page 31 for more information about 
recording TV programs.

Using the Guide, you can scroll through a list of the 
current and upcoming television programs and channels 
available from your television service provider. The Guide 
displays the channel and network, as well as the program 
title, scheduled time block, and a brief description of the 
program. The number of days displayed depends on your 
television service provider; most providers display up to 
14 days. By selecting a program title, a detailed 
description of the program appears at the bottom of the 
window.

Using Media Center without a Guide
Before using Media Center, it is important to complete the 
Media Center setup wizard. This takes you through steps 
to identify your TV signal source and scan for channels 
you are able to receive from your TV provider. By 
scanning for channels, you can manually select TV 
programs to watch and record, even if your country/
region is unable to download the TV listings information 
of the Guide listed above.

The Television Program Guide data may not be available 
in your country/region. You can still record TV programs 
without a Guide; see “Recording programs manually with 
or without a Guide” on page 31.

If you have already completed the setup wizard, but want 
to change your settings or scan for TV channels again:

1 Press the Media Center Start button  on the 
remote control.

2 Select Settings, General, Media Center Setup, 
and then select Run Media Center Setup Again.

3 Follow the onscreen instructions to scan for your 
channels.

n
Your HP Digital Entertainment Center requires 
a connection to the Internet to access the 
Guide.
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Television Program Guide Errors
If there is no Guide data available when you try to 
download or search for Guide information, the 
following messages may appear:

■ Download Incomplete: We were unable to locate 
any Television Program Guide information for the 
following reason: Guide data is not available for 
the country or region setting you selected in the 
Control Panel Settings.

■ Search in My TV is unavailable because there is no 
Guide information.

■ The current lineup and/or location selected for the 
Guide is not supported.

■ The Guide information is either missing or corrupt.
■ No data available.
■ Channel information is currently not available.

If you receive any of these messages, then the Guide data 
is not available in your country/region, and you cannot 
use Television Program Guide features. Check back 
periodically to see if Guide data has been provided. n

The Television Program Guide is not available 
in all countries/regions.
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Viewing the Television Program Guide

1 Press the Media Center Start button  on the 
remote control.

2 Select My TV, and then select Guide.

3 Use the arrow buttons to select a channel, and then 
use the arrow buttons to scroll through up to two 
weeks of programming for that channel.

4 Select a program, and then press OK to watch it. 
Press the Record button on the remote control to 
record the program.

If you press the Guide shortcut button on the remote 
control while you are already in the Guide, you can 
select one of the Guide filter categories, such as Movies, 
to search for a movie.

Press the More information button on the remote 
control to access another menu for more options of 
searching the Guide.

w
Make sure the HP Digital Entertainment 
Center is connected to the Internet and Media 
Center is properly set up before you try to 
change the Guide settings.

n
When you select a channel and then press OK 
on the remote control, you can view up to 
two weeks of programming information. Use 
the scroll arrows at the bottom of the 
window.

i
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Setting up how Media Center 
downloads the Guide
Your HP Digital Entertainment Center must have a 
connection to the Internet and you must select a TV listings 
provider in the Media Center Setup Wizard before you 
can use and download the Guide information. You can 

set up Media Center to download the Guide information 
when you connect to the Internet, or you can select to 
manually download the Guide.

1 Press the Media Center Start button  on the 
remote control.

2 Select Settings, General, Automatic 
Download Options, and then select:

■ Download when connected: Connect to the 
Internet, and Media Center automatically 
downloads the Guide.

Or

■ Manual download: Connect to the Internet 
and then manually download the Guide in 
Media Center TV Settings menu.

3 Follow the onscreen instructions. When the Television 
Program Guide starts downloading from the Internet, 
it can take up to 30 minutes, depending on the 
amount of data to download and the speed of your 
Internet connection.

n
No data available appears next to each 
channel if the Guide has not been 
downloaded. This can occur if the HP Digital 
Entertainment Center does not have an 
Internet connection or if there is no service 
available in your country/region.

n
If your HP Digital Entertainment Center has a 
DSL connection, your HP Digital Entertainment 
Center is always connected. The Guide is 
downloaded at a specified time every few 
days. The download interval varies, 
depending on the ISP.
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Manually downloading the Guide

1 Press the Media Center Start button  on the 
remote control.

2 Select Settings, TV, Guide, and then select Get 
Latest Guide Listings.

3 Follow the onscreen instructions. The Guide can take 
up to 30 minutes to download, depending on the 
amount of data to download and the speed of your 
Internet connection.

Adding a postal code to receive the correct Guide

1 Press the Media Center Start button  on the 
remote control.

2 Select Settings, TV, Guide, and then select Set 
Up Guide Listings.

3 Click Next, and follow the onscreen instructions.

4 Enter your postal code, and then select Next for 
Media Center to determine which TV/Program 
Guide listings are available for your country/region.

5 Follow the onscreen instructions.

Adding missing channels to the Guide
Some program channels may not appear in the Guide. To 
add the names and numbers of the channels that are 
missing or to change the association between channel 
numbers and lineups:

1 Press the Media Center Start button  on the 
remote control.

2 Select Settings, TV, Guide, and then select Add 
Missing Channels to add the names and numbers 
of the channels you are missing.

3 Click Add Channel.

4 Use the numeric keypad on your keyboard to 
enter the number of the missing channel, and then 
select Next.

5 Enter the correct channel number, and then 
select Add.

6 Repeat steps 3 through 5 to add additional channels. 

7 Click Done when you have added all the channels.

.
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Editing channels in the Guide
Some program channels may not appear correctly in the 
Guide information. To edit the channel numbers that are 
incorrect for your TV provider information:

1 Press the Media Center Start button  on the 
remote control.

2 Select Settings, TV, Guide, and then select Edit 
Channels to edit the channel numbers currently 
assigned by Media Center.

3 Select Edit Numbers.

4 Use the numeric keypad on your keyboard to enter 
the number of the correct channel, and then select 
OK on the remote control.

5 Select Assign channel to assign a new channel 
number.

Or

Select Share channel to share the channel with 
another channel.

6 Click Save when you have edited all the channels.

7 If you need to go back to the channel numbers 
automatically assigned by Media Center, select 
Restore Default.

Removing channels from the Guide

1 Press the Media Center Start button  on the 
remote control.

2 Select Settings, TV, Guide, and then select Edit 
Channels to remove the channels you do not want 
to appear in the Guide.

3 Select a check next to a channel you want to remove, 
and then press the OK button on the remote control 
to remove the channel from the lineup. 

4 Select Save when you have selected all the channels 
to be removed from the Guide.
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Searching for TV Programs
To find a TV program, you can enter a title or keyword or 
select a category in your Guide by using your remote 
control.

1 Press the Media Center Start button  on the 
remote control, select My TV, and then select 
Search.

2 Select Title. Use the numeric keypad on your remote 
control or your keyboard to enter a program title 
word, and then press OK on the remote control.

Or

Select Keyword. Use the numeric keypad on your 
remote control or your keyboard to enter a 
descriptive word that would appear in a program 
title or program description, and then press OK on 
the remote control.

3 To scroll through search results, use the arrow buttons 
to select a program, and then press OK. If multiple 
times for the program are displayed, select a time 
and press OK.

4 To begin watching the program in full-screen mode, 
select the program, and then press OK. If the 
program is not currently playing, select Record or 
Record Series, and then press OK.

n
■ Using Categories to search can help you 

find, for example, all football games. A title 
or keyword search displays every program 
that has “football” in the title or 
description.

■ The TV search results do not include 
previously recorded TV programs.

n
Guide filtering features, such as searching by 
keyword or category, are available for select 
models only.
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Searching for TV programs using categories
You can search the Guide to find a TV program by 
selecting a category using your remote control. Some 
categories are not available in all countries/regions.

1 Press the Media Center Start button  on the 
remote control, select My TV, and then select 
Search.

2 Select Categories.

3 Select a category of program types, such as 
Movies.

4 Select an option such as Genres or Top Rated.

5 Select a sorting option, such as By movie title.

6 Use the arrow buttons to scroll through 
search results and to select a program. Then 
press OK on the remote control.

7 Select an option to find out more about the 
program, to watch it, to schedule a recording, or to 
view other showings of your program.
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Recording TV Programs
Media Center allows you to record TV programs so that 
you can watch them when it is convenient. You can 
record the program you are watching, or you can record 
a future program or series from the Guide, the Search, 
or the Recorded TV window in My TV. You can record 
two programs at the same time if your HP Digital 
Entertainment Center has two TV tuners that have the 
same type of TV signal input (select models only).  

If a recording error occurs, the program will not be 
recorded unless the conflict is resolved. If you try to 
schedule a recording and another is already scheduled 
for the same time, a conflict window appears and gives 
you the option to record the new program or record the 
previously scheduled program.

To make sure your program is being recorded, select 
My TV, Recorded TV, and then select Scheduled. 
The Record icon also appears next to the program in 
the Guide while you are recording. The Record icon 
disappears when the recording is complete.

Record Series means that you select to record each 
episode of that program from one channel. Media Center 
won’t record duplicate episodes. Media Center also looks 
for alternative times to record an episode if a recording 
conflict arises.

 Recording icons

The Record icon appears in the Television 
Program Guide next to the program 
scheduled to record.

The Record Series icon appears in the 
Television Program Guide next to each 
occurrence of a program in a series that is 
scheduled to be recorded.

The Record Conflict/Error icon appears in 
the Television Program Guide and the 
taskbar if another program is scheduled to 
be recorded at the same time.

w
If you turn off (shut down) your HP Digital 
Entertainment Center, Media Center will not 
record a scheduled program. The HP Digital 
Entertainment Center must be turned on or in 
standby mode to record a TV program. The 
HP Digital Entertainment Center will not 
automatically go into standby mode if Media 
Center is open.

Make sure you turn off the monitor and turn 
down or mute the volume if, for example, 
you have a scheduled recording in the middle 
of the night and do not want to be disturbed.

n
For more information about recording to your 
HP Personal Media Drive, see “About 
Recording TV to the HP Personal Media 
Drive” on page 126.
30 Microsoft Windows XP Media Center Edition 2005 Software Guide



W
a
tc

h
in

g
 a

n
d
 R

ec
o
rd

in
g
 

TV
 P

ro
g
ra

m
s

Recording TV from the Guide
To record a current or future program or series from the 
Guide:    

1 Press the Media Center Start button  on the 
remote control, select My TV, and then select 
Guide.

2 To find the program you want to record, use the 
arrow buttons on the remote control, and then select 
the program. You can also use the numeric keypad 
on the remote control to enter a channel number. 
Press the right arrow button in the Guide to select a 
program that will be broadcast in the future.

3 Press the Record button on the remote control.

The Record icon  appears next to the program in 
the Guide. Press Record twice to record a series.

The Record Series icon  is displayed to 
indicate a series. Press Record again to cancel the 
recording.

4 To return to the previous window, press Back on the 
remote control.

5 If there is a recording conflict, Media Center displays 
a message and allows you to select which program 
you want to record.

Recording programs manually 
with or without a Guide
You do not need the Television Program Guide to record 
TV. You can record a TV program by pressing the Record 
button on the remote control while watching live TV, or 
you can select a specific date, channel, and recording 
time period in Media Center. 

For some programs, you may want to begin recording 
before the scheduled beginning and after the scheduled 
ending of the program.

 

n
■ Recorded TV programs that have been 

copied to a DVD can be played on your 
HP Digital Entertainment Center and on 
some DVD players.

■ Recorded TV programs can be backed up as 
part of a full system backup and restored 
to the same HP Digital Entertainment 
Center, but not to other PCs.
Watching and Recording TV Programs 31



To record a program without a Guide:

1 Press the Media Center Start button  on the 
remote control, press the Live TV button, and then 
press Record to begin recording your program.

Or

Click Start, and then click Media Center, or press 
the Media Center Start button on the remote control, 
select My TV, Recorded TV, and then select Add 
Recording.

2 Select Channel and Time.

3 Select the channel number box and enter the 
channel number using the numeric keypad on the 
keyboard or remote control.

4 Select the (+) or (–) buttons, and then press Enter on 
the keyboard or OK on the remote control to scroll 
through choices and enter the recording frequency, 
date, start and stop times, and storage and quality 
options.

5 To set the recording and return to the Recorded TV 
window, select Record in the window, and then 
press Enter on the keyboard, or OK on the remote 
control.

6 To return to the previous window, press the back 
arrow on the keyboard, or press Back on the remote 
control.
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Recording quality and hard disk drive storage space
The space available for recording TV programs depends 
on your hard disk drive size, the percentage of hard disk 
drive space allocated to recorded TV, and the recording 
quality setting.

To get the maximum recording time, change the recording 
quality to Fair instead of the default setting of Best.

1 GB = 1 billion bytes when referring to hard disk drive 
capacity. Actual formatted capacity is less.

Copying recorded TV programs to DVD or CD
You can record TV programs to DVD in Media Center to 
create a backup copy or to save space on your hard disk 
drive by using the following procedure. These DVDs can 
be played from an HP Digital Entertainment Center and 
from some set-top DVD players.

The HP Digital Entertainment Center includes several 
other recording software programs for you to create CDs 
and DVDs. You can use InterVideo WinDVD Creator to 
record the recorded TV program to a format that can be 
played from an HP Digital Entertainment Center and from 
some set-top DVD players. See “Using WinDVD Creator” 
on page 101.

For more detailed information about recording CDs and 
DVDs, refer to information on the HP Support Web site at:

http://www.hp.com/support

n
Refer to Media Center Help for more 
information about recording errors, 
advanced recording features, and My TV 
settings.

Quality of 
recording

Hard disk drive space 
used *

Best 2.7 GB/hour
Better 2.1 GB/hour
Good 1.4 GB/hour
Fair 1.2 GB/hour
*This table shows approximate sizes of recorded TV program files. 
Some files may be smaller or larger.

n
TV programs that have been encrypted 
(protected) by the broadcaster cannot be 
copied and played back on any player other 
than the HP Digital Entertainment Center that 
recorded the program.
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To copy a recorded TV program to CD or DVD:

1 Press the Media Center Start button  on the 
remote control.

2 Select More Programs.

3 Insert a blank DVD+RW, DVD+R, CD-RW, or 
CD-R disc.

4 Select Create CD/DVD.

5 Select the type of CD or DVD you want (Music 
or Data).

6 Enter a title for your DVD by using the numeric 
buttons on the remote control, and then select OK.

7 Select Recorded TV.

8 Select the Recorded TV programs you want to copy 
to CD or DVD.

9 Select View DVD or View CD.

10 Select Create DVD or Create CD.

11 Select Yes.

12 Follow the onscreen instructions to complete burning 
your TV show to disc.

Playing Recorded TV Programs
Recorded TV is the storage place for all your recorded 
programs. In the Recorded TV window, you can sort your 
programs by name, date, or category. You can also 
delete a recorded program or series of programs and 
check for any recording errors.

1 Press the Media Center Start button  on the 
remote control, select My TV, and then select 
Recorded TV.

2 To organize all of your previously recorded 
programs, select Sort by Date or Sort by Title.

3 To begin watching the program, select the recorded 
program you want to watch, and then press OK on 
the remote control.

Media Center places recorded TV programs in the 
Recorded TV folder that is located in your Shared 
Documents folder on your hard disk drive.

n
Refer to Media Center Help for more 
information about recording errors, 
advanced recording features, and My TV 
settings.
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The HP Tunes and My Music areas in Media Center are 
great ways to play, organize, and back up your music 
files. HP Tunes is designed to work with the Apple iTunes 
program in your All Programs menu, and My Music is 
designed to work with the Windows Media Player 
program.

HP Tunes
With HP Tunes, you can play your favorite music which 
you have added to your iTunes music Library. For more 
information about using HP Tunes, see “Using HP Tunes 
with Media Center” on page 36.

n
When a CD is in your drive, it takes longer to 
open HP Tunes. Also, you must be in HP Tunes 
to play your iTunes music files from within 
Media Center. 

n
If you leave HP Tunes area, your music files 
stop playing. 

HP Tunes is designed to work with 
Apple iTunes.
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My Music
With My Music, you can find and play your favorite 
music files and CDs you have added to the Windows 
Media Player Library. For more information about using 
My Music, see “Using My Music with Media Center” on 
page 43.

Using HP Tunes with Media Center
iTunes is a software program from Apple located in your 
All Programs menu that works together with the HP 
Tunes area in Media Center. HP Tunes is linked to your 
iTunes music Library. Both programs work together to 
organize and play back your favorite music files, CDs, 
and created playlists.

Some tasks you must do in the iTunes program with your 
keyboard and trackball, and some tasks you can do 
from within Media Center with your remote control. For 
example, you must add music files to the iTunes library 
before you can access them in HP Tunes in Media 
Center. Also, you can record your playlists to CDs in the 
iTunes program but not in Media Center.

My Music is designed to work with Windows 
Media Player.

HP Tunes menu in Media Center
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Completing the iTunes setup wizard
To use HP Tunes and iTunes with Media Center, you 
need to:

1 Initialize iTunes by completing a setup wizard.

2 Add songs to the iTunes Library, and create playlists. 
HP Tunes displays only the songs and playlists that 
are in iTunes.

To complete the iTunes setup wizard:

1 Close Media Center, if open.

2 Double-click the iTunes shortcut icon on 
the desktop.

3 When the iTunes Setup Assistant wizard opens, 
follow the onscreen instructions.

4 Close iTunes.

5 Open Media Center, and then open HP Tunes.

Delays with HP Tunes
When using HP Tunes, you may experience some delays, 
or HP Tunes may not function properly. These delays can 
occur because:

■ There is an audio CD in the drive, and HP Tunes is 
attempting to connect to an Internet database to find 
music information, such as song titles.

■ There is a large collection of songs in your music 
library.

■ Windows Media Player or another music playback 
program is set as the default player. See the 
following procedure.

n
For more information on using the iTunes 
program, refer to the HP Support Web site at: 
http://www.hp.com/support

n
If you do not complete these steps, an error 
message appears when HP Tunes is 
launched, which indicates that a problem has 
occurred in iTunes that is preventing this 
program from running.
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Selecting a default audio player
If you have already set your default audio player to 
Windows Media Player, you may experience a delay 
when trying to open HP Tunes. To resolve this issue:

1 Close Media Center, if open.

2 Double-click the iTunes shortcut icon on the 
desktop.

3 When the iTunes default player for audio files 
message opens, place a check mark in the Do not 
show this message again check box, and then 
click Yes or No.

4 If you have not completed the iTunes Setup Assistant 
wizard, follow the onscreen instructions.

5 Open Media Center, and then open HP Tunes.

Adding Music to the iTunes Library
To create your iTunes music Library, you can import music 
files from a CD, download iTunes music files from the 
iTunes Music Store or the Internet, or import them from 
your hard disk drive.

n
If your songs don’t appear in HP Tunes, make 
sure your songs are added to the iTunes 
Library. You may need to close and open 
Media Center to update your display. For 
more information about adding songs and 
creating playlists in iTunes, see the Help menu 
in iTunes.
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Adding music files from a CD in iTunes

1 With your trackball, click Start  on the 
Windows taskbar, choose All Programs, iTunes, 
and then click iTunes.

2 Insert an audio CD.

3 Select your CD under the Source menu.

4 Make sure the songs you want to add to your library 
are selected. A check mark appears next to the song 
when it is selected.

5 Click the Import icon in the toolbar to 
bring the songs into the library.

Adding music files from the Internet
For more information about downloading music from the 
iTunes Music store, refer to the Help menu in the iTunes 
program.

1 Connect to the Internet.

2 Follow the online instructions to download your 
songs. If songs are downloaded from the iTunes 
Music Store, they appear in your iTunes Library.

3 If songs are downloaded to your desktop, drag 
them into the iTunes Library. If the files are in an 
unprotected .wma format, they are encoded into 
.aac files by default (or into the importing format 
you select from the Preferences menu) and placed 
into the library.

4 To change your import format:

a Click the Edit menu, and then select 
Preferences.

b Select the Importing tab.

c Select the Import Using drop-down menu, and 
then select an import format.

5 Select Library. Songs are listed alphabetically or by 
the sort order of the library column heading you 
select.

n
If your songs are listed as track numbers 
instead of names, make sure the HP Digital 
Entertainment Center is connected to the 
Internet so iTunes can look up the song and 
album names.
Playing Music Files 39



Adding music files from your hard disk drive
If the music files are in another format, iTunes will 
automatically convert most files to the .aac format before 
it adds them to your iTunes Library.

1 Click Start  on the taskbar, choose All 
Programs, iTunes, and then click iTunes.

2 Click the File menu, and then select Add File 
to Library. Click the drop-down arrow to browse 
for your music files. Select your file, and then 
click Open.

Using supported music file types
You can play the following types of digital audio files in 
iTunes. By default, iTunes converts several file types to 
.aac files when you import them into the iTunes Library.

Some file types, such as protected .wma files and other 
proprietary file types, cannot be played in iTunes.

Media Center cannot play .aac files from My Music.

With iTunes, you can share .mp3, .aiff, .wav, and .aac 
files between other computers on a local network.

Changing song name, genre, artist, or album in iTunes
For more information about changing name, genre, artist, 
or album information with iTunes, refer to the Help menu 
in the iTunes program. It is not possible to make these 
changes from within HP Tunes in Media Center.

n
MP3 files are the most compatible music file 
format for playing back on most PCs and 
other audio playback devices.

File extension File type
.aac Apple Lossless Encoder
.aiff Apple Compressed Encoded
.wav Windows audio file
.mp3 Audio files

n
You can select Media Center as the default 
player for any of the listed file types. Refer to 
iTunes Help for information about supported 
file types.
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Playing CDs with HP Tunes
When you insert a CD that has not been added to your 
iTunes music Library, it will be listed under Playlists or 
Albums. If it has been added to your library, it will be 
displayed under Songs, Albums, Artists, or Genres.

1 Press the Media Center Start button  on the 
remote control, and then select HP Tunes.

2 Insert a CD.

3 Select Playlists or Albums.

4 Scroll through the displayed playlists or albums, and 
then select your CD title. If the songs on this CD 
weren’t added to your iTunes music Library, this 
playlist or album will disappear when you eject 
the CD.

Creating a Playlist with iTunes
A playlist is a customized list of songs that you saved 
together and can play later or record to CD. Using 
playlists, you can group various digital music files 
together and determine the order in which you want the 
files to play.

You can create a playlist that includes several tracks from 
various CDs or even a playlist that contains background 
music for a slide show.

You can use iTunes or HP Tunes in Media Center to create 
playlists.

1 Click Start  on the taskbar, choose All 
Programs, iTunes, and then click iTunes again.

2 Click File, and then select New Playlist.

3 Type a name for your playlist.

4 Select Library.

5 Drag your music files from the library to your 
Playlist icon.

6 Select the Playlist icon to check whether your songs 
were added. Your playlist is now available in the 
HP Tunes area of Media Center.

n
For more information about music file 
compatibility with iTunes, go to the iTunes 
Help menu.

n
If your playlist doesn’t appear in HP Tunes, 
make sure your songs are in your iTunes 
library. You may need to close and open 
Media Center to update your display.
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Creating and Editing a Queue List with 
HP Tunes
A queue (or Now Playing) list is a temporary list of songs 
that are scheduled to be played in the order they were 
selected. A queue list acts like a group of songs you select 
to play on a jukebox. You can continue to add songs, or 
you can delete songs from your queue list. You also have 
the option of saving your queue list as a playlist.

1 Press the Media Center Start button  on the 
remote control, and then select HP Tunes.

2 Select Songs.

3 Use the arrow buttons on the remote control to select 
a song, and then press OK on the remote control to 
place a check mark next to the song.

4 Select Add to Queue.

5 Press the Back button on the remote control to return 
to the queue list. Click View Queue and then Edit 
Queue to select songs to move or delete.

Or

Repeat steps 2 through 4 to add more songs to your 
queue list.

Creating Music CDs with iTunes
To create a music CD using iTunes:

1 With your trackball, click Start on the Windows 
taskbar, choose All Programs, select iTunes, and 
then click iTunes.

2 Click the Edit menu, and select Preferences.

3 Click the Burning tab, and choose Audio CD as 
the disc format.

4 Click the Use Sound Check check box if you 
would like all songs on the CD to play at the same 
volume level, and click OK.

5 Click the File pull-down menu, and select New 
Playlist.

n
Once you create a queue list, you can save 
it as a playlist that you can play again and 
again.
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6 Enter a name for your new playlist, and an empty 
playlist window opens.

7 Drag and drop selected songs from your source to 
your new playlist.

8 Click the Burn Disc icon in the toolbar 
area. When the disc is finished recording, 
the Burn Disc icon disappears.

9 Insert a blank CD-R disc into your drive 
(double-layer DVD+R discs are not compatible).

10 Click Burn Disc to begin recording your playlist.

For more information about creating music CDs with 
iTunes, click the Help menu in the iTunes menu bar. For 
help online, go to:

http://www.hp.com/support

Using My Music with Media Center
You can copy digital music files and organize a music 
library by using My Music in Media Center or by using 
the Windows Media Player program.

Music files that are added from within My Music in 
Media Center are copied into the Windows Media 
Player Library and are then accessible from within 
Media Center.

In My Music you can:

■ Play CDs or selected music tracks from your created 
Windows Media Player Library that you access in 
Media Center.

■ Select and edit a personalized queue list of songs 
from your library.

■ Delete songs from a music library or queue list.
■ Burn your favorite songs to CDs.
■ Back up your music tracks to a DVD or to an 

HP Personal Media Drive.

n
iTunes music files cannot be recorded to 
double-layer DVD media.

n
IMPORTANT: HP supports the lawful use of 
technology and does not endorse or 
encourage the use of our products for 
purposes other than those permitted by 
copyright law.

My Music menu in Media Center
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Adding Music to My Music Library
When you add music files to your My Music library, they 
are placed into the music library in Windows Media 
Player. The added music files can immediately be found 
and played back by using My Music in Media Center.

You can also add music files to your music library from 
within the Windows Media Player program. For more 
information about adding and deleting music files to 
the library, use the Windows Media Player Help menu.

Adding music files from your hard disk drive

1 Press the Media Center Start button  on the 
remote control, and then select My Music.

2 Press the More Information button on the remote 
control, and select Add Music.

3 Select Add folders, and then select Next.

4 Select Add folders on this computer, and then 
select Next.

5 Use the arrow buttons on the remote control to 
select a location. Press the OK button to expand a 
folder. When you find the folder that contains your 
music folder, select it by making sure an arrow 
appears next to the folder. Repeat this step to add 
additional folders, and then select Next and then 
select Finish.

n
You can store your music files in the My Music 
folder or in other folders on your hard disk 
drive, but you need to add those files to the 
Windows Media Player Library for Media 
Center to be able to find and play them.
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Adding music files from a CD
To add the CD tracks to your Media Center music library:

1 Press the Media Center Start button  on the 
remote control, and then select My Music.

2 Insert a CD into the CD drive.

3 Select Albums.

4 Select the Album CD you want to add to your music 
library.

5 Select Copy CD. The first time you copy a music 
CD you must select your copy-protection option, 
and then follow any onscreen instructions.

6 Select Yes to begin copying tracks to your music 
library. This process may take several minutes, 
depending on the length of your music tracks.

7 Click OK.

n
Each time you add music files outside of 
Windows Media Player, you must use the 
Tools menu to add music files to your 
Windows Media Player Library for Media 
Center to find them.
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Deleting music files from the My Music library

1 Press the Media Center Start button  on the 
remote control, and then select My Music.

2 Select Songs.

3 Use the arrow buttons on your remote control to scroll 
through your songs. Select the song you want to 
delete, and then press OK on the remote control.

4 Select Delete, and then select Yes.

Using supported music file types 
You can play the following types of digital audio files in 
My Music. Refer to Windows Media Player Help for more 
information about supported file types.

File extension File type
.cda CD audio
.wav Windows audio file
.mp3, .m3u MP3
.asx, .wm, .wma, 
.wmv, .wmp, .wmx

Windows Media audio 
files

n
For more information about music file 
formats, use Windows Media Player Help 
and Media Center Help.

Only supported audio file types are 
displayed in the My Music window. 
Unsupported files won’t play.
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Playing Music Files in My Music
When you first open Media Center and open the My 
Music window, you may not find any music files listed 
unless there is a music CD in your CD drive or unless you 
have already added audio files to your Windows Media 
Player Library.

When you copy music files using Windows Media Player 
and your computer is connected to the Internet, the CD 
information is copied and displayed in Media Center and 
in the Windows Media Player Library.

If you insert a music CD when Media Center is not open, 
a message appears asking what you want to do. You can 
select Windows Media Player as your default audio 
player. If you have another program set as the default 
audio player, Windows opens the program and begins 
playing the CD.

n
You can place all your music files into the My 
Music folder or into other folders on your 
hard disk drive, but you need to add those 
files to the Windows Media Player Library for 
Media Center to be able to find and 
play them.
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Playing an album in My Music

1 Press the Media Center Start button  on the 
remote control.

2 Select My Music.

3 Insert a music CD into the CD drive.

4 Select Albums.

5 Select the album you want to play.

6 Select Play.

Playing a song in My Music
You can play a song from anywhere in My Music. You 
can select it from the View Song list, or from the Album, 
Artist, and Genre lists. You can also play a single song 
from a playlist:

1 Press the Media Center Start button  on the 
remote control.

2 Select My Music.

3 Select Songs. The list displays all the songs in your 
library.

4 Use the arrow buttons to select a song, and then 
press OK on the remote control to play it.

n
You can select Visualize in the Now Playing 
window to see a visualization while you play 
a music track.
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Creating a Queue List in My Music
A queue list is a temporary list of songs that is created in 
My Music as you select songs, albums, or playlists to 
play. You can continue to add songs or you can delete 
songs from your queue list.

You can create a queue list and save it as a playlist that 
you can access in Media Center.

1 From the My Music window:

■ Select Songs, use the arrow keys to select a 
song you want, and then select Add to Queue.

Or

■ Select Albums or Playlists, select an album or 
a playlist, and then select Add to Queue to 
add the entire album or playlist to the queue.

2 Use the Back button on the remote control to go back 
to the Songs, Albums, or Playlists menu if you want to 
select more songs to add to your queue list. Repeat 
step 1.

3 After you add the last song for your queue list, select 
Play. All songs in your queue list are played in the 
order you have selected them.

Finding and Playing an Album in My Music
1 In the Media Center Start menu, select My Music, 

and then select Albums.

2 Use the arrow buttons to select an album, and then 
press OK on the remote control. You can also press 
Play on the remote control to play the album. The 
Now Playing window opens, and the album starts 
playing.

3 In the Play window, you can also select:

■ View Cover to view cover art and play one 
track.

■ View Queue to view an ordered list of all 
tracks that will be played on the album.

■ Shuffle to rearrange the play order.
■ Repeat to play the album again.
■ Copy CD to copy an album into your Media 

Library.
■ Buy Music to connect to the Internet, find CD 

information, and buy music CDs. To go back to 
Media Center, press Start on the remote control.

■ Visualize to view a picture while listening to 
a song.

4 To return to the previous window, press Back on the 
remote control.
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Creating a Playlist in My Music
A playlist is a customized list of songs you can keep to 
play later or record to CD. Using playlists, you can group 
various digital music files together and determine the 
order in which you want the files to play.

You can create a playlist that includes several tracks from 
various CDs or even a playlist that contains background 
music for a slide show.

You can create playlists in Windows Media Player or 
from within Media Center.

To create a playlist:

1 Select My Music, and then select either Albums, 
Artists, Playlists, Songs, or Genres.

2 Use the arrow buttons to navigate to the music you 
want to add to your playlist.

3 Press OK to select a song.

4 Select Add To Queue. A confirmation displays that 
the music was added to the list of music in the queue.

5 Select the inset window in the lower-left corner to go 
to the Queue.

6 On the Queue screen, select Edit Queue, and then 
select Save As Playlist.

7 Use the numeric keypad to enter a name for the 
playlist, and then select Save.

n
If your HP Digital Entertainment Center is 
connected to the Internet, the CD track titles 
and cover art appear in Media Center.
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Copying Music Files to CD in My Music
To copy your music files to CD:

1 Press the Media Center Start button  on the 
remote control, and select More Programs.

2 Insert a blank CD-R disc.

3 Select Create CD/DVD.

4 Use the arrow buttons on the remote control to select 
the Untitled text box.

5 Use the numeric keypad buttons on the remote 
control to enter a name for your CD, and then 
select OK.

6 Select Music.

7 Select the music files to record. A check mark 
appears next to the song when it is selected. Use 
the Back button on the remote control to select more 
songs from different menus.

8 When you are finished adding songs, select View 
CD to see the songs you have selected. If you want 
to delete songs, use the arrow buttons on the remote 
control to select the X next to the song you want to 
delete. Press OK on the remote control to delete the 
song from your list of songs to be recorded to CD. 
This does not delete the song from your library.

9 Select Create CD.

10 Select Yes.

n
IMPORTANT: HP supports the lawful use of 
technology and does not endorse or 
encourage the use of our products for 
purposes other than those permitted by 
copyright law.
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Use the HP Image Zone Plus and My Pictures areas in 
Media Center to view and print your pictures.

HP Image Zone Plus
HP Image Zone Plus is a software program located in 
your All Programs menu that works together with the 
HP Image Zone Plus area in Media Center. Both 
programs work together to organize, search for, and 
display your digital images. It is designed to organize 
your photos, scanned images, and video clips by date, 
keyword, or place. For more information about using 
HP Image Zone Plus, see “Using HP Image Zone Plus in 
Media Center” on page 54.

My Pictures
With My Pictures, you can view and print your pictures 
from the folders you create in the My Pictures directory 
in Windows Explorer. For more information about using 
My Pictures, see “Using My Pictures in Media Center” 
on page 65.
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Working with Digital Images
You can connect a digital image source, such as a digital 
camera or a digital video camera, directly to the 
HP Digital Entertainment Center or through a docking 
station. Most digital picture files you copy or download 
from the device appear in the My Pictures folder.

You can copy digital picture files from the memory cards 
used by digital cameras and other digital imaging 
devices by using the memory card reader (select 
models only).

r

Using HP Image Zone Plus in Media Center
Some tasks you must do in the HP Image Zone Plus 
program on your desktop with your keyboard and 
trackball, and some tasks you can do from within Media 
Center with your remote control. For example, you must 
add your pictures to the HP Image Zone Plus program 
on the desktop before you can access them in HP Image 
Zone Plus area in Media Center.

n
For specific details on using the HP Image 
Zone Plus program, click the Help link in the 
control area of the program window.

HP Image Zone Plus menu in Media Center
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Creating your picture catalog in HP Image Zone Plus
The first time you open the HP Image Zone Plus program, 
a message appears asking you if you want to create a 
catalog by indexing images in the My Pictures folder and 
its subfolders. This catalog allows you to search for your 
pictures by date, keyword, or place by using HP Image 
Zone Plus.

1 Using the trackball, double-click the 
HP Image Zone Plus icon on your 
desktop.

Or

Click Start on the taskbar, choose All Programs, 
HP, and then click HP Image Zone Plus. The 
HP Image Zone Plus window opens.

2 When the catalog message appears, click OK to 
index the images and place them in the HP Image 
Zone Plus catalog.

3 At the top of the gallery window, click the My 
Images tab (A), and then click the Select All 
check box below it to see all of the images in the 
catalog. You can also select a drive under the 
Folders Menu (B) to browse for images.

4 Click Help at the bottom of the window for more 
information about creating your picture catalog in 
HP Image Zone Plus.
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A Mode tabs are used to choose a work area.

B The Preferences button is used to customize 
HP Image Zone Plus and change some tab 
settings.

C Gallery of images.

D Selection tray displays images that you 
have selected.

B

A

C

D

n
You can click Go to My Pictures at the top of 
the HP Image Zone Plus window to open the 
My Pictures folder in Windows Explorer.
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Creating albums
You can organize your pictures into albums by using the 
HP Image Zone Plus program. After you create your 
picture albums in HP Image Zone Plus, you can then view 
them in Media Center.

To create an album:

1 Using your trackball, double-click the HP Image 
Zone Plus icon on the desktop.

2 Click the My Images tab.

3 Select the pictures that you want to place into an 
album.

4 Click Albums under View/Search.

5 Click Albums, and then select New Album.

6 To change the title of the album, just select it and type 
in a title using your keyboard. You can now view 
your albums in Media Center.

Modifying a date assigned to your pictures
Digital cameras and scanners assign a creation date to 
digital images. HP Image Zone Plus automatically 
recognizes this creation date and organizes your pictures 
by date.

To change a date: 

1 Using your trackball, double-click the HP Image 
Zone Plus icon on the desktop.

2 Click the My Images tab, and then click All by 
Date under View/Search.

3 Select a picture to assign a new date.

4 Select a date, and then click Set.

n
After you create your picture albums in the 
HP Image Zone Plus program, you can then 
view them in Media Center.
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Assigning a keyword to your pictures

1 Using your trackball, double-click the HP Image 
Zone Plus icon on the desktop.

2 Click the My Images tab, and then click All by 
Keyword.

3 Select your picture by clicking it. You can select more 
than one picture, if desired.

4 Click My Selections Menu at the bottom of the 
window, choose Keywords, and then click Assign 
to All (New Keyword).

5 Select a keyword from the available keywords list, 
and then use the arrow button to add the keyword to 
the Assign to all box. Click Assign, and then 
click OK.

Or

Click New, type in a keyword, and then click OK. 
The new keyword is added to the keyword list. Use 
the arrow button to add the keyword to the Assign to 
all box.

Assigning a place to your pictures

1 Using your trackball, double-click the HP Image 
Zone Plus icon on the desktop.

2 Click the My Images tab, and then click All by 
Place under View/Search.

3 Select your picture by clicking it. You can select more 
than one picture, if desired.

4 Click Assign and then click Assign again.

5 Click the map to find your location. Each time you 
click the map, it zooms in closer. Use the arrow 
buttons surrounding the map to move around on the 
map. When your location is in the center of the cross 
symbol, click Assign.

6 Click OK.

7 Click Close.

n
You can assign more than one keyword. You 
can also edit or delete assigned keywords.

n
There are multiple ways to move around the 
HP Image Zone Plus map: you can click and 
drag or point and click the small globe.
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Searching for pictures in HP Image Zone Plus
You can search for pictures by date, keyword, and place 
by using your remote control or trackball in Media 
Center. HP Image Zone Plus automatically organizes your 
pictures by date, based on the date assigned by the 
camera when the picture was taken or the date the 
picture was scanned.

1 Press the Media Center Start button  on the 
remote control.

2 Select HP Image Zone.

3 Select Search.

4 Select By date. Use the number keypad on the 
remote to enter the start and end date range. The 
date range of the pictures you selected is displayed 
in this window.

Or

Select By keyword. Select a keyword, and then 
press OK on the remote control.

Or

Select By place. Use the arrow buttons on the 
remote control to rotate the globe and numbers 1 
through 5 to zoom in or out. When you have picked 
a location, press OK. Locations that have pictures 
assigned to them will have a colored dot on the map.

n
You must open the HP Image Zone Plus 
program from the desktop to assign dates, 
keywords, and places to your pictures.
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Viewing Pictures in HP Image Zone Plus

Viewing a slide show in HP Image Zone PLus
When viewing images, you can view a slide show of all 
your images, individual albums, or pictures selected from 
a search.

1 Press the Media Center Start button  on the 
remote control.

2 Select HP Image Zone.

3 Select the pictures you want to view as a slide show, 
and then press OK. If you do not select the pictures 
you want to view as a slide show, Media Center 
displays all pictures.

4 Select Play slide show, and then press OK on the 
remote control.

5 Use the media playback keys on the remote control 
or the controls that appear at the top of the window 
to control the playback of your slide show.

Viewing a slide show with music in HP Image Zone Plus 

1 Select My Music on the Media Center Start menu.

2 Select the music you want, and then press OK on the 
remote control. If the music doesn’t start 
automatically, press the Play button on the remote 
control.

3 To go back to the Media Center Start menu, press 
Start on the remote control.

4 Select HP Image Zone.

5 Select the pictures, and then press OK.

6 Select Play slide show, and then press OK. When 
Media Center switches to full-screen mode, the inset 
window disappears, but the music continues to play.
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Editing Pictures in HP Image Zone Plus
You can make changes to your pictures and video clips in 
HP Image Zone Plus. Some of the editing features include 
removing red eye, cropping or resizing images, rotating 
images, and adjusting the color, brightness, and 
sharpness of your images.

For more information about the editing tools, refer to the 
Help menu in the HP Image Zone Plus program.

Using supported picture file types with HP Image Zone Plus 
HP Image Zone Plus supports the following types of image 
files, video files, and audio files.

■ Only supported image file types are displayed in 
My Pictures. Unsupported files are skipped in a 
slide show.

■ Corrupted and unsupported image file types display 
a generic image icon but cannot be displayed in 
Media Center.

■ Some file types are supported only if appropriate 
filters and software are installed.

File extension File type
.jpg, .jpeg Joint Photographic Experts 

Group
.tif, .tiff Tagged Image File Format
.gif Graphics Interchange Format
.bmp Bitmap
.fpx FlashPix Bitmap
.pcx Bitmap Graphics
.pdf Portable Document Format
.png Portable Network Graphics

n
If the message Image cannot be displayed 
appears, the file may be corrupted, or it may 
be an unsupported file type. You may need to 
edit your image with a photo editor and save 
it in a supported file format.
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Printing Pictures in HP Image Zone Plus
1 Press the Media Center Start button  on the 

remote control.

2 Select HP Image Zone.

3 Select the picture group you want to print from.

4 Select Print images.

5 Select the picture you want to print.

6 Select Print. Follow any onscreen instructions.

You need to set up your printer before you can print 
from Media Center.

n
You cannot use the Print button on the remote 
control in HP Image Zone Plus.
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Creating a Backup Disc of Your Pictures

Create an incremental backup disc of images you have 
put into HP ImageZone Plus.

1 Click Start, All Programs, HP, HP ImageZone 
Plus, and then click HP ImageZone Plus again.

2 Select the Backup and Restore tab, and then 
click Backup on the left side of the window.

3 Click Start backup.

4 Select Full backup or Incremental backup, and 
then click Next.

5 Select your media type and then select your drive 
from the drop-down list, and click Next.

6 Insert a blank disc, and then click Write disc.

7 Follow any onscreen instructions.

Burning a Label on a LightScribe Media Disc 
Creating a label with LightScribe is a separate process 
from recording data, music, or picture files onto a disc. 
Depending on the LightScribe software you use, you can 
create a label before or after you burn files onto the disc. 
Labels can be a simple title and contents list, or you can 
get more creative by adding backgrounds and images. 

There are two ways to create a LightScribe disc label in 
HP Image Zone Plus. You can create a simple backup 
label or a more customized label. The backup label 
contains a disc title, the name of the person logged in, 
and the date and time the label is recorded and takes 
about 3 to 7 minutes to print. A customized label can 
contain different formats and pictures and can take up 
to 40 minutes to print, depending on how much data 

is on the label. You can continue to work on your 
HP Digital Entertainment Center while LightScribe is 
burning the label. Both labels have a grayscale image 
similar to a black and white photograph.

n
Any images you have not organized and 
edited in HP Image Zone Plus will not be 
backed up.

n
You must use LightScribe media discs that are 
designed to work with the LightScribe 
recording software and are sold separately.
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Creating a simple backup disc label with HP Image Zone Plus

1 Click Start, All Programs, HP, HP ImageZone 
Plus, and then click HP ImageZone Plus again. 

2 Select the Backup and Restore tab, and then 
click Backup on the left side of the window. 

3 Click Start backup. 

4 Select Full backup or Incremental backup, and 
then click Next. 

5 Select your media type, make sure the Use 
LightScribe Media check box is selected, and then 
click Next. 

6 Select the LightScribe drive from the drop-down list, 
and then click Next. 

7 Insert a blank disc, and then click Write disc. If you 
want to create a LightScribe label for your backup 
disc, insert a LightScribe disc with the label side up. 

8 After the backup is complete, turn your disc over with 
the label side facing down, and then click Write 
Label. 

9 When the label is complete, click Next, and then 
click Finish.

Creating a customized disc label with HP Image Zone Plus

1 Click Start, All Programs, HP, HP ImageZone 
Plus, and then click HP ImageZone Plus again. 

2 Select the Backup and Restore tab, and then 
click Backup on the left side of the window. 

3 Click Print LightScribe label. 

4 Insert disc, and click OK. The Sonic Express Labeler 
program opens. 

5 Click Text and then enter your text for Title and 
Subtitle.

6 For each line of content description, click New and 
enter text for the information you want to include, 
and then click OK. 

7 Click OK again when finished adding all the 
contents information. 

8 Select a label template by clicking Layout and 
choosing a layout. 

9 Select a background, if desired, by clicking 
Background. Select one of the provided 
backgrounds or click More to find one of your own 
images to use as a background.

10 When you are satisfied with the appearance of your 
label design, insert the LightScribe disc (label side 
down) into the disc drive tray and then click Print.

n
If a message is displayed that the disc is not 
recognized, you may not have the correct 
media or you may need to flip the disc over 
to record your label. To record the label, the 
disc must be placed label side down in the 
disc tray.
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11 From the Disc Label menu, select LightScribe 
12cm Disc. 

12 Select a Contrast Level and then click OK to begin 
burning the label. The disc is ejected when the label 
is complete.

Using My Pictures in Media Center
My Pictures is a folder on your hard disk drive in the My 
Documents folder, and it is a Media Center menu item 
that allows you to view and search for your digital images 
by using the remote control or the keyboard and 
trackball.

It provides all the tools you need for viewing, organizing, 
editing, printing, sharing, and protecting your digital 
images.

n
A sudden bump or vibration of the HP Digital 
Entertainment Center during the labeling 
process may affect the quality of the label.

My Pictures menu in Media Center

My Pictures folder in Windows 
Explorer
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Adding Pictures to My Pictures

Adding picture files from your hard disk drive

1 Press the Media Center Start button  on the 
remote control, and then select My Pictures.

2 Press the More information button on the remote 
control and select Add Pictures.

3 Select Add folders, and then select Next.

4 Select Add folders on this computer, and then 
select Next.

5 Use the arrow buttons on the remote control to 
select a location. Press the OK button to expand a 
folder. When you find the folder that contains your 
picture folder, select it by making sure an arrow 
appears next to the folder. Repeat this step to add 
additional folders, and then select Next.

6 Select Finish.
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Viewing Pictures in My Pictures
After you organize your pictures in the My Pictures folder 
in Windows Explorer, open Media Center to view your 
pictures:

1 Press the Media Center Start button  on the 
remote control.

2 Select My Pictures. The right side of the window 
shows a small picture image (thumbnail) and, if 
you’ve organized your pictures into folders, folder 
icons. The pictures are displayed just as you 
organized them in the My Pictures folder in 
Windows Explorer.

3 Use the arrow buttons on the remote control to 
move through your picture files and folder files, and 
select a picture.

4 Press OK to select a picture or folder to view. The 
selected picture opens in full-screen mode.

5 Press OK again to zoom in 150%; press OK again to 
zoom in 225%. Press the arrow buttons to pan 
across a picture. To return the picture to the original 
size, press OK a third time.

n
From the My Pictures menu, you can select 
Settings to:
■ Select a slide transition, slide time delay, 

and a background color.
■ Include picture folders you have created.
■ Show captions.
■ Display your pictures randomly.
■ Show song information during slide show.
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Viewing pictures as a slide show

1 Press the Media Center Start button  on the 
remote control.

2 Select My Pictures.

3 Select the folder of pictures you want to view as a 
slide show, and then press OK.

4 Select Play Slide Show, and then press OK.

5 Press the More information button on the 
remote control, and then select Picture 
Details. The picture name, location, last 
modification date, and resolution appears, if 
available.

6 Press the Back button to go to a previous picture. Use 
the arrow buttons to display the next or previous 
pictures.

If you do not select the pictures you want to view as a 
slide show, Media Center uses the first folder listed. If you 
have picture files that are not stored in folders you 
created, Media Center plays all files stored in the My 
Pictures folder.

Viewing a slide show with music in My Pictures

1 Select My Music on the Media Center Start menu.

2 Select the music you want, and then press OK on 
the remote control. If the music doesn’t start 
automatically, press the Play button on the remote 
control.

3 Press the Media Center Start button  on the 
remote control to go back to the Media Center 
Start menu.

4 Select My Pictures.

5 Select the folder of pictures, and then press OK.

6 Select Play Slide Show, and then press OK. 
When Media Center switches to full-screen mode, 
the inset window disappears but the music continues 
to play.

i
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Using supported picture file types in My Pictures 
You can view the following types of image files in 
Media Center.

■ Only supported image file types are displayed in 
My Pictures. Unsupported files are skipped in a 
slide show.

■ Folder icons appear even if the images inside them 
cannot be displayed.

■ Corrupted and unsupported image file types display 
a generic image icon but cannot be displayed in 
Media Center.

■ Some file types are supported only if appropriate 
filters and software are installed.

File extension File type
.jpg, .jpeg Joint Photographic Experts 

Group
.tif, .tiff Tagged Image File Format
.gif Graphics Interchange Format
.bmp Bitmap
.wmf Windows MetaFile
.png Portable Network Graphics

n
If the message Image cannot be displayed 
appears, the file may be corrupted or it may 
be an unsupported file type. You may need to 
edit your image with a photo editor and save 
it in a supported file format.
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Editing Pictures in My Pictures

Fixing red eye or contrast

1 Press the Media Center Start button  on the 
remote control.

2 Select My Pictures.

3 Select the picture you want to edit.

4 Press the More information button on the remote 
control, and then select Picture Details.

5 Select Touch Up.

6 Select Red Eye or Contrast, and then press OK.

7 After you select the options you want to fix, select 
Save. The picture is displayed with the new 
settings.

8 Select Yes to save changes and replace the 
original picture file.

Cropping pictures in My Pictures

1 Press the Media Center Start button  on the 
remote control, and select My Pictures.

2 Select the picture you want to edit.

3 Press the More information button on the remote 
control, and then select Picture Details.

4 Select Touch up, and then select Crop.
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5 Select the arrows under the picture to move the 
picture side to side, up or down. Select the 
magnifying glass to move the cropping tool in or out. 
Select the rotate tool to move the cropping tool to a 
vertical or horizontal position.

6 After you select the options you want to fix, select 
Save. The picture is displayed with the new settings.

7 Select Yes to save changes and replace the original 
picture file.

Rotating pictures
If your picture appears horizontally or vertically and you 
want to change the orientation, you can change it in 
Media Center:   

1 Press the Media Center Start button  on the 
remote control.

2 Select My Pictures.

3 Select the picture you want to rotate.

4 Press the More information button on the remote 
control, and then select Picture Details.

5 Select Rotate, and then press the OK button on the 
remote control.

Printing Pictures in My Pictures
1 Press the Media Center Start button  on the 

remote control.

2 Select My Pictures.

3 Select the picture you want to print.

4 Press the More information button on the remote 
control, and then select Picture Details.

5 Select Print, and then select Print again.

6 Follow any onscreen instructions.

You may need to set up your printer before you can print 
from Media Center.
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Copying Pictures to CDs and DVDs 

You can copy your pictures to CDs and DVDs in Media 
Center or by using the RecordNow! program. Refer to 
“Creating (Burning) CDs and DVDs with RecordNow!” on 
page 83. You can also create a LightScribe label for your 
CD or DVD if you have a LightScribe optical drive and 
you use LightScribe media discs. Refer to “Disc Labeling 
with LightScribe” on page 92.

1 Press the Media Center Start button  on the 
remote control.

2 Select More Programs.

3 Insert writable media (CD-R, CD-RW, DVD+R, or 
DVD+RW) into the drive.

4 Select Create CD/DVD.

5 Select the Untitled area, and enter the name of your 
disc by using the numeric keys on the remote control, 
and then select OK. Use the Clear button to delete 
letters.

6 Select Pictures.

7 Select the pictures you want to copy. A check mark 
appears next to a picture when you select it.

8 Select View CD/View DVD. From here you can 
delete a picture, add more pictures, or change the 
name of your disc.

9 After you have selected all of your pictures, select 
Create CD/Create DVD. 

10 Select Yes. Media Center displays a message when 
your disc has been created.

n
In Media Center, all pictures are copied to CDs 
as .jpg files.
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The My Videos window in Media Center makes it easy to 
play home video files you created or video files you 
downloaded from the Internet.

In My Videos you can:

■ Play videos that are stored anywhere on your hard 
disk drive.

■ Create a CD or DVD of your video files.
■ View your videos in full-screen mode or from an inset 

window in Media Center.
■ Display your video details, such as the name and 

date your video file was modified.
■ View small image (thumbnail) and title of video file.

n
Each user has a separate My Videos folder 
that can be opened only by that person. You 
can share videos with others by storing them 
in the Shared Video folder.
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Playing Digital Videos in Media Center
After you organize your videos in the My Videos or 
Shared Video folder in Windows Explorer, open Media 
Center to watch your videos.

1 Press the Media Center Start button  on the 
remote control.

2 Select My Videos.

3 Select the video folder you want, and then press 
OK. The video folder opens, displaying a list of 
video files. You may need to use the scroll arrows at 
the bottom of the window to display all videos.

4 Select the video file, and press OK again. The 
video plays in full-screen mode. Use the trackball to 
resize the window if you want to watch your video 
while doing something else on your desktop.

5 To exit full-screen mode and return to the previous 
window, press Back on the remote control. Your 
video continues to play in the inset window.

6 When the video is finished, select Restart, and then 
press OK to replay the video, or select Done to 
close the file and return to the My Videos window.

n
■ Use the trackball to select the up and down 

arrows at the bottom of the window to 
scroll to other pages of video files and 
folders.

■ You can maximize the media playing in the 
inset window by using the arrow buttons to 
select the inset window and then pressing 
OK on the remote control.
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Using Supported Video File Types
You can view the following types of video files in Media 
Center. Other file types are supported if your HP Digital 
Entertainment Center has the correct software installed.

Transferring and Recording Video Files
Once you capture your video by using video capture and 
editing software, you can use Media Center to find it and 
add it to your My Videos area.

Recording an analog video file
Refer to “Capturing analog video” on page 104 for more 
information about capturing and recording videos to 
DVDs or CDs from an analog video camera.

Recording a digital video file
Refer to “Identifying requirements for capturing video” on 
page 102 and “Capturing digital camcorder video” on 
page 103 for more information about recording videos to 
DVDs or CDs from a digital camera.

File extension File type
.avi Video file
.mpeg, .mpg, 
.mpe, .m1v, 
.mp2, .mpv2

Movie file

.wm, .asf Windows Media file

.wmv Windows Media A/V file

n
For more information about supported video 
file types, refer to Media Center Help menu.
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Creating a CD/DVD from Video Files
To create a CD/DVD from your videos:

1 Press the Media Center Start button  on the 
remote control.

2 Select More Programs.

3 Insert writable disc (CD-R, CD-RW, DVD+R, or 
DVD+RW), and then select OK.

4 Select Create CD/DVD.

5 Select the Untitled area and enter the name of your 
disc by using the numeric keys on the remote control, 
and then select OK. Use the Clear button to delete 
letters.

6 Use the arrow buttons on the remote control to select 
Video, and then select OK.

7 Select the video file you want to copy, and then 
select View CD/View DVD.

8 Select Add More if you want to add additional 
video files to your disc.

9 Select View CD/View DVD to check the contents 
of your disc before recording them.

10 Select Create CD/Create DVD to begin recording 
the disc, and then select Yes.
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Watching DVDs in Media Center allows you to control the 
playback with your remote control. If you play your DVD 
in another program outside of Media Center, you will not 
be able to use the remote control. 

Playing DVD Movies in Media Center
1 Press the Media Center Start button  on the 

remote control.

2 Insert the DVD into the drive. If you have other 
media playing, Media Center asks if you want to 
play the DVD. Select Yes or No. If you don’t select 
an option, the DVD autoplays in full-screen mode 
after a few seconds.

Or

If the DVD is already in the drive, select Play DVD 
from the main start menu. The DVD movie begins 
playing in full-screen mode.

3 If a DVD menu appears, use the remote control or 
the trackball to select the DVD menu items and 
control the DVD movie playback.

4 To stop playing the DVD, press Stop on the remote 
control.

5 To change the window size while the DVD movie is 
playing, move the trackball for the Resize icon to 
appear.

6 Click the Resize icon on the taskbar, 
and then you can manually adjust the 
window size.

n
To view more information about a DVD that 
you are watching, such as the DVD title, 
chapter title, genre, parental rating, length 
and current position, press the More 
information button on the remote control.
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Changing the DVD Movie Language
To select DVD language settings for subtitles, closed 
captioning, and viewing the DVD:

1 In the Media Center Start menu, select Settings.

2 In the Settings window, select DVD.

3 In the DVD Settings window, select Language.

4 Use the arrow buttons on the remote control to 
select (+) or (–). Press OK on the remote control to 
scroll through the languages available.

5 When you find the one you want, use the arrow 
buttons to select Save, and then press OK on the 
remote control.

6 To return to the main Settings window, press the 
Back button.

Changing DVD Audio Settings
To select DVD audio settings for viewing the DVD:

1 Press the Media Center Start button  on the 
remote control

2 Select Settings.

3 Select DVD.

4 Select Audio. The Audio Properties window opens.

5 Using your trackball or keyboard, select your 
speaker and sound options, and then click OK.
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If your HP Digital Entertainment Center is equipped with a 
radio tuner input (FM TUNER IN), Media Center can play 
FM radio. The Radio window in Media Center makes it 
easy to play FM radio stations using your remote control.

In Radio you can:

■ Listen to FM radio stations.
■ Set up pre-sets of your favorite radio stations.
■ Delete or organize your radio station pre-sets.
■ Use the time-shifting features: pause, rewind, and 

fast-forward up to 30 minutes of radio programs.

n
Make sure you connect the FM radio antenna 
to the back of the HP Digital Entertainment 
Center before selecting an FM radio station. 
This antenna is for select models only.
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Playing FM Radio Stations
1 Connect the FM radio antenna to the back of the 

HP Digital Entertainment Center, to the connector 
labeled FM ANTENNA IN.

2 Press the Media Center Start button  on the 
remote control.

3 Select Radio.

4 Enter a radio station number by using the numeric 
keypad on the remote control or your keyboard.

Or

Select the Seek (–) or (+) buttons for Media Center 
to find the next playable station.

Or

Select the Tune (–) or (+) buttons to manually find a 
station.

5 If you want, select Save to save it as one of your 
nine pre-set stations.

6 Select Start FM to begin playing that station.

7 Use the playback controls on the remote control, such 
as Pause, Rewind, and Fast-Forward to control radio 
playback. If you press the Pause button, Media 
Center continues to record the program for up to 
30 minutes. Press Play to resume listening to the 
program where you left off.

8 Select Back to return to the previous window.
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Organizing Pre-set Radio Stations
1 Press the Media Center Start button  on the 

remote control.

2 Select Settings.

3 Select Radio.

4 Select the up arrows and down arrows next 
to each pre-set station to move it to a different 
position.

Or

Select the Delete icon (X) to delete a pre-set 
station.

Or

Select Auto Sort to sort your pre-set stations in 
numerical ascending or descending order.

5 Select Save to save your changes.

6 Select Back to return to the previous window.

Using the FM Radio and the TV Signal 
at the Same Time
The FM radio signal and My TV input signal share a 
single tuner card. This means that you are unable to 
watch or record TV and listen to FM radio at the same 
time unless you have two TV tuners. When Media Center 
is scheduled to start a recording, a warning appears that 
says FM radio stops when the TV recording starts. If you 
do not select Cancel recording, then Media Center 
automatically stops radio and begins recording TV.
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You can make your own music or data CDs if your 
HP Digital Entertainment Center has a CD-RW or DVD 
Writer, or double-layer drive (select models only).

Your HP Digital Entertainment Center has four recording 
software programs: iTunes, Windows Media Player, 
Sonic RecordNow!, and Windows XP. 

You can copy or download music to its library and can 
then organize or copy the music files. You can copy 
Windows Media files that have a .wma extension, .mp3 
files, or .wav files to a CD by using a CD-RW drive or a 
DVD Writer drive. You can also use iTunes or Windows 
Media Player to copy music files to a portable device or 
memory card.

CD-R discs are compatible with more players than 
CD-RW discs.

Creating (Burning) CDs and DVDs with 
RecordNow!

RecordNow! allows you to record your music, 
video, and data files to disc in a few easy steps. 
Open the RecordNow! program, select one of 
the tabs listed below, and then follow the 

onscreen instructions to create a CD or DVD with 
RecordNow!.

Audio: Create a music CD for a car or 
home CD player, or for a PC.

Data: Create or add to an appendable 
data disc.

Backup: Create a backup copy of your important files.

Video: Make an exact copy of a video disc in your 
collection.

For more information about recording CDs and DVDs, 
refer to the Help menu in the RecordNow! software 
program.

n
Burn is an industry term used to describe the 
recording of information onto a DVD or CD. 
Optical recording uses a laser beam to place 
information onto the disc, thus the term 
burning.

If your recording fails, manually select a 
slower recording speed, if available, each 
time you make a recording. Refer to the Help 
menu in your selected software program 
for more information about selecting a 
slower recording speed.
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Verifying disc recorded without errors
When writing data to disc, such as a backup CD, it is 
recommended that you use RecordNow! because it offers 
the feature that allows you to know if your disc has 
recorded without errors. RecordNow! enables this setting 
as a default selection. 

To check the status of this verify setting:

1 Using the trackball, click Start on the Windows 
taskbar.

2 Choose All Programs.

3 Click Sonic RecordNow!, and then click 
RecordNow! again.

4 Click Options (wrench icon).

5 Select Data.

6 Make sure “Verify data written to the disc 
after burning” has a checkmark in the check box.

Erasing rewritable discs before recording
Previously recorded files on CD-RW discs must be erased 
before recording music files. CD-R discs cannot be 
erased.

To erase a rewriteable disc:

1 Using the trackball, click Start on the Windows 
taskbar.

2 Choose All Programs.

3 Click Sonic RecordNow!, and then click 
RecordNow! again.

4 If you need to erase a disc (CD-RW or DVD+RW): 
Insert the disc, select the Home screen (house icon) 
tab, and then Erase Disc under the Home 
Screen tab.

Creating music CDs with RecordNow!
RecordNow! creates closed-session music CDs, which 
means you must record all music files on one CD in one 
recording session. Music files can be recorded repeatedly 
on a rewritable CD-RW disc, but all previously recorded 
files must be erased first. CD-R discs cannot be erased.

CD-R discs play in most home and car stereos. CD-RW 
discs play only in some stereos.

You can use RecordNow! to create audio CDs to play in 
your car or home CD player, or on your HP Digital 
Entertainment Center.

.

n
IMPORTANT: HP supports the lawful use of 
technology and does not endorse or 
encourage the use of our products for 
purposes other than those permitted by 
copyright law.
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Creating CDs to play in your car or home CD players

1 Using the trackball, click Start, choose All 
Programs, Sonic RecordNow!, and then click 
RecordNow! again.

2 Select the Audio Projects tab.

3 Select Audio CD for Car or Home CD Player.

4 Insert a music CD to view the tracks on 
your CD. Select View if you would like 
to look at another optical drive.

Or

Click Find, and then click either Scan for Music or 
Browse to find music files on your hard disk drive 
that you want to record.

5 Select the tracks you want to record, and then 
click Add.

6 Click the Burn icon when you have 
added all the audio files to your music CD 
project.

7 Click Yes.

8 When prompted, insert a blank CD-R or CD-RW disc. 
If you want to play your music CD in your home or 
car stereo, use a CD-R disc. CD-RW discs may not 
play in some stereos.

9 Click OK.

10 Click Done when recording is complete.

Click the Help icon, and then select RecordNow! 
Help for more information about recording music CDs 
with the RecordNow! program.

Creating CDs to play on your HP Digital Entertainment Center

1 Using the trackball, click Start, choose All 
Programs, Sonic RecordNow!, and then click 
RecordNow! again.

2 Click the Audio Projects tab.

3 Select Jukebox CD.

4 Insert a music CD to view the tracks on your CD. 
Click Find, and then click either Scan for Music or 
Browse to find music files on your hard disk drive 
that you want to record.

5 Select the tracks you want to record, and then 
click Add. Press and hold the Control (Ctrl) key to 
select more than one track.

6 Click the Burn icon when you have 
added all the audio files to your music CD 
project.

7 Click Yes.

n
Press and hold Control (Ctrl) on your 
keyboard to select more than one track.
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8 When prompted, insert a blank CD-R or CD-RW disc. 
If the CD-RW disc is not blank, RecordNow! prompts 
you to erase it and then automatically begins writing 
to it when it is erased. If you want to play your music 
CD in your home or car stereo, use a CD-R disc. 
CD-RW discs may not play in some stereos.

9 Click OK.

10 Click Done when recording is complete.

Click the Help icon, and then select RecordNow! 
Help for more information about recording music CDs 
with the RecordNow! program.

Creating a music CD
When recording music files, it is important to note that:

■ To play your music CD in a home or car stereo, it 
needs to be recorded as a music CD in CD Audio 
(CDA) format, not as a data CD.

■ You must record all music files in one recording 
session because RecordNow! closes the CD after 
recording is complete. Music files can be recorded 
repeatedly onto a rewritable (CD-RW) disc, but all 
previously recorded music files must be erased first.

■ As you add music files in the recording session, 
RecordNow! calculates and displays the amount 
of recording time available to record additional 
music files.

■ You can’t record song titles unless you make an exact 
copy of a music CD in your collection.

■ If you try to record more than a standard CD can 
hold, RecordNow! displays a message warning you 
that all the tracks may not fit on your disc.

n
RecordNow! scans for all audio files, even the 
sounds from your operating system. If you 
don’t want to display some of these sounds, 
you can select the Options icon (wrench), and 
then select Audio. Select Hide audio files 
shorter than (in seconds), and then type the 
number of seconds and click OK.

n
IMPORTANT: HP supports the lawful use of 
technology and does not endorse or 
encourage the use of our products for 
purposes other than those permitted by 
copyright law.
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Storing Files on a DVD or CD
Unlike music CDs, data DVDs and CDs can be recorded 
in multiple sessions:

1 Using the trackball, click Start, choose All 
Programs, Sonic RecordNow!, and then click 
RecordNow! again.

2 Select the Data Projects tab.

3 Insert a blank or appendable CD-R, 
CD-RW, DVD+R, DVD+RW, or double-
layer DVD+R (select models only) disc 
into your drive, and then click Data Disc.

■ If the disc is blank, follow the onscreen 
instructions.

Or

■ If the disc is full, insert a blank or another 
appendable disc.

Or

■ If you are adding files to a disc, follow the 
onscreen instructions.

4 To name your disc, select Volume Label, and 
then type a name over it. RecordNow! assigns a 
name based on the recording date if you don’t type 
a name.

5 Add your data files to the file selection window:

■ Click the Add Files and Folders button, find 
and select your folders and files, and then click 
Add. Repeat this step until all files are added.

Or

■ Drag your file from your desktop or from 
anywhere in Windows Explorer into the file 
selection window. Repeat this step until all files 
are added.

6 Click the Burn icon when all of your files 
have been added.

7 Click Done when recording is complete.

Click the Help icon, and then click RecordNow! Help 
for more information about recording data files with the 
RecordNow! program.
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Storing data files on disc
When storing data files on a disc, it is important to 
note that:

■ You can add new data files to a CD-R and 
a DVD+R in a later recording session, until 
the disc is full. With DVD+R discs, you 
need to select the correct setting in 
RecordNow! to record files in a later session. To do 
this, insert your recorded DVD, open RecordNow!, 
click the Options icon (wrench), click Data, select 
the recording option you want, and then click OK.

■ When you record files that have the same name 
as previously recorded files, RecordNow! updates 
the file and the previous version is overwritten.

■ RecordNow! allows you to change the names of files 
you want to record and the files that were previously 
recorded.

■ As you select data files to record to your disc, 
RecordNow! calculates and displays the amount of 
recording space used on your disc.

Copying a DVD or CD
RecordNow! allows you to make a copy of a music 
or data disc from your collection.

To make a copy of a music or data disc from your 
collection:

1 Using the trackball, click Start, choose All 
Programs, Sonic RecordNow!, and then click 
RecordNow! again.

2 Select the Data Projects tab.

3 Select Exact Copy.

n
An appendable disc can have additional files 
added to it, if there is disc space available. 
Recorded audio CDs are closed-session discs 
that are not appendable.

n
You can rename your files in the file selection 
window by selecting and typing over the 
current name. This does not affect the original 
files on your hard disk drive.
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4 Insert the CD or DVD you want to copy.

5 Click the Copy icon.

6 Insert a blank DVD or CD into the drive, and then 
click OK.

7 Click Done when the recording is complete.

Archiving Files on a CD or DVD
1 Using the trackball, click Start, choose All 

Programs, Sonic RecordNow!, and then click 
RecordNow! again.

2 Select the Backup Projects tab.

3 Select File Archive.

4 Insert a blank CD or DVD into the drive.

5 Place a check mark in the Changed since box to 
limit the scan to files that have been changed since 
the last time you completed a file archive.

6 Add your files to the Archive window:

■ Select one or more categories from the list on the 
left, and click Scan. RecordNow! scans your 
hard disk drive for files related to the category 
and moves them to the Archive window on the 
right.

Or

■ Drag files from the Windows Explorer to the 
Archive window.

7 Click the Burn icon when all of your files 
have been added.

If the files do not fit on one disc, File 
Archive asks you for additional discs.

8 Click Done when recording is complete.

n
IMPORTANT: HP supports the lawful use of 
technology and does not endorse or 
encourage the use of our products for 
purposes other than those permitted by 
copyright law.
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Creating an Image File
RecordNow! can take all the files from a CD or DVD and 
convert them into a single file called an image file. You 
can use the image file to reproduce the original disc. This 
is often used when you need to make multiple copies of 
the same disc.

Saving an Image
1 Click Start, choose All Programs, Sonic 

RecordNow!, and then click RecordNow!.

2 Select the Backup Projects tab.

3 Select Save Image.

4 Insert the source disc into the drive.

5 Click Browse to set the destination and name of the 
image file.

6 Click the Save icon to create the image file.

Burning an Image
1 Click Start, choose All Programs, Sonic 

RecordNow!, and then click RecordNow!.

2 Select the Backup Projects tab.

3 Select Burn Image.

4 Click the Browse button to locate your saved 
image file.

5 Click the Burn icon.

6 Insert a blank recordable CD or DVD into 
the drive.

7 Click Done when recording is complete.
90 Microsoft Windows XP Media Center Edition 2005 Software Guide



C
re

a
ti
n
g
 (

B
u
rn

in
g
) 

C
D

s 
a
n
d
 D

V
D

s

Recording Video Files
Video quality depends on the quality of the source files, 
the PC speed, and its graphics processing ability. For 
more information about recording VHS files to DVD, refer 
to “Recording VHS files direct to DVD” on page 110.

Using Disc Labels

 

n
Your DVD Writer or CD Writer drive will 
not copy commercially available DVD movies. 
Most commercial DVDs are encoded to 
prevent unauthorized duplication.

w
When labeling your DVDs, do not use sticky 
labels. They can cause the DVD to play 
erratically. Instead, write on the DVD with a 
felt-tip pen to label it.

Or, you can create a LightScribe label for your 
disc if you have a LightScribe optical drive 
and you use LightScribe media discs. Refer to 
“Disc Labeling with LightScribe” on page 92.
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Disc Labeling with LightScribe
LightScribe (select models only) is a direct disc labeling 
technology providing you a simple way to burn precise, 
silk-screen quality labels. It combines the CD or DVD drive 
of your HP Digital Entertainment Center with specially 
coated discs (sold separately) and enhanced disc-labeling 
software.

A LightScribe-enabled CD or DVD disc drive uses the 
optical laser in the drive to burn a label onto a thin dye 
coating on the label side of the disc. There is no ink to 
smear or paper to curl, and there are no adhesives to 
loosen.

LightScribe media is identified by the LightScribe logo on 
the retail packaging and on the inner hub area of the disc 
itself. Your HP Digital Entertainment Center comes ready 
to work with many versions of LightScribe media; 
however, as new media versions are introduced you will 
need to update the driver software for your LightScribe-
enabled CD or DVD drive. Get driver updates from the 
HP Support Web site.

LightScribe requirements
Burning a label with LightScribe requires three things:

■ LightScribe-enabled DVD drive
■ LightScribe software

■ LightScribe discs (sold separately)

Burning a label on a LightScribe media disc
You can burn the label before or after you burn the disc 
with data, music, or picture files. Labels can be a simple 
title and contents list or you can get more creative by 
adding backgrounds and images.

You can design and burn the label with InterVideo Disc 
Label or Sonic Express Labeler.

1 Click Start, All Programs, InterVideo 
DiscLabel, and then click InterVideo DiscLabel 
again.

2 Select a template style from the Template menu, and 
click Apply.

3 Double-click the title text box, if present, or click 
Add Text.

4 Type the text into the Rich Text Edit window, and then 
click OK.

5 With the text box selected (click the box once), use 
the Text toolbar to modify the font, color, and other 
text properties.

6 Double-click the list text box, if present, or click Add 
List to add a list of contents to the label.

7 Click Add to add a row to the list.
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8 Move the cursor over a list row item (Title, Artist, 
Length), and double-click to edit the item.

9 Click OK when you are finished with the list.

10 Click Edit Background, and then click Change 
Background to add a background image to the 
label.

11 Click Add Image and follow the onscreen 
instructions to browse to and select an image file. 
InterVideo Disc Label supports .jpg, .bmp, and .png 
image files.

12 Click and drag the image to the area you want it to 
appear on the label. You can resize the image by 
clicking and dragging the sides or corners of the 
image.

13 When you are satisfied with the appearance of your 
label design, click LightScribe Print. Click Print, 
insert the LightScribe media (label side down) in the 
disc tray, and then click OK.

Burning a label with Sonic Express Labeler

1 Click Start, All Programs, Sonic RecordNow!, 
and then click Express Labeler.

2 Select the Project area, make sure that Disc Label 
is selected.

3 Click Text, and then enter text for the Title and 
Subtitle.

4 For each line of content description, click New and 
enter text for the information you want to include, 
and then click OK.

5 Select a label template by clicking Layout and 
choosing a layout.

n
LightScribe creates a grayscale (monochrome) 
image similar to a black and white 
photograph.

n
To remove an image from the label, click the 
image, and then press Delete on your 
keyboard.

n
You can open the Express Labeler from within 
RecordNow! by clicking Label Disc.
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6 Select a background, if desired, by clicking 
Background. Select one of the provided 
backgrounds, or click More to find one of your own 
images to use as a background.

7 When you are satisfied with the appearance of your 
label, insert the LightScribe media disc (label side 
down) into the disc drive tray, and then click Print.

8 From the Disc Label menu, select LightScribe 
12cm Disc.

9 Select a Contrast Level, and then click OK to begin 
burning the label.

Creating a LightScribe label after burning a disc with iTunes
iTunes works with Sonic Express Labeler to allow you to 
burn labels on a data CD or audio CD. The playlist you 
create in iTunes to burn a disc is automatically imported 
into Express Labeler so that this information is available 
for you to use on your LightScribe label. To use Express 
Labeler from iTunes, the data or music tracks in the 
playlist you are using must fit on a single CD.

1 Click Start, All Programs, iTunes, and then click 
iTunes again.

2 Burn a data or audio CD with iTunes. When the 
burning process is complete, click Yes on the Create 
LightScribe Label window.

3 In the Step 1: Select Project area, make sure that 
Disc Label is selected. 

4 Select a label template by clicking Layout and 
choosing a layout. The various layouts show different 
amounts of playlist information. Some show only the 
playlist title and others show the playlist title and 
track names. You can edit playlist information by 
clicking Text to open the Edit Text window.

5 Select a background, if desired, by clicking 
Background. Select one of the provided 
backgrounds or click More to find one of your own 
images to use as a background.

6 When you are satisfied with the appearance of your 
label design, insert the LightScribe disc (label side 
down) into the disc drive tray and then click Print.

n
LightScribe creates a grayscale (monochrome) 
image similar to a black and white 
photograph.

n
LightScribe creates a grayscale (monochrome) 
image similar to a black and white 
photograph.
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7 From the Disc Label menu, select LightScribe 
12cm Disc.

8 Select a Contrast Level and then click OK to begin 
burning the label.

The estimated time to complete the label displays, along 
with a progress bar to show you the time remaining. You 
can continue to work on your HP Digital Entertainment 
Center while LightScribe is burning the label.

Using Compatibility Information
An important feature of a DVD Writer/CD Writer drive is 
its high level of compatibility with other optical drives and 
CD and DVD players:

■ The CDs that you create play in most home and car 
stereos and in most computer DVD-ROM and 
CD-ROM drives.

■ The DVDs that you create are compatible with some 
DVD video players and with most computer 
DVD-ROM drives.

■ CD-R discs are more compatible with home and car 
stereos than CD-RW discs are.

Your DVD Writer/CD Writer drive is able to read from 
and record to almost every type of optical disc. Writing 
speed rates for the DVD Writer/CD Writer drive are fast, 
allowing quick recording times.

Understanding video recording lengths and video quality settings

* Minutes listed are approximate and not exact.

Video quality 
setting GB/Hour

Minutes* on a 
4.7 GB DVD

Minutes* on a 
8.5 GB DVD

Fair 1.2 170 minutes 300 minutes 

Good 1.4 145 minutes 260 minutes 

Better 2.0 100 minutes 185 minutes 

Best 2.7 80 minutes 144 minutes 

n
CD-R discs are more compatible with home 
and car stereos than CD-RW discs.



Identifying Disc Feature and Compatibility

NOTE: The HP Digital Entertainment Center comes with 
the Double-Layer DVD Writer. It supports single-layer and 
double-layer DVD media. Double-layer technology gives 
you greater capacity and allows you to store up to 
8.5 GB* of data on double-layer DVD+R media.

Double-layer is a new technology. Double-layer media 
compatibility will vary widely with some home DVD 
players and DVD-ROM drives.

*1 GB is defined as 1 billion bytes. 1 GB = 1 billion 
bytes when referring to hard disk drive capacity. Actual 
formatted capacity is less.

For the latest disc compatibility information for your 
HP Digital Entertainment Center, go to the HP Support 
Web site at: http://www.hp.com/support

Disc File type

Can be 
recorded 
onto Plays in PC

Plays in 
home or car 
stereo

Plays in home 
DVD player

CD-ROM Data No Yes No No

Music No Yes Yes Varies by model

CD-R Data Yes Yes No No

MP3 music Yes Yes Varies by model Varies by model

CD-RW Data Yes Yes No No

MP3 music Yes Yes Varies by model Varies by model

DVD-ROM Data No Yes No No

DVD movie No Yes No Yes

DVD+R Data Yes Yes No No

DVD movie Yes Yes No Varies by model

Double-
layer 
DVD+R

Data Yes Varies by model No Varies by model

DVD movie Yes Varies by model No Varies by model

DVD+RW Data Yes Yes No No

DVD movie Yes Yes No Varies by model

VCD DVD movie No Yes No Varies by model
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Using the Optical Drive 
Quick Reference Table

n
Double-layer DVD technology is supported by 
select models only.

n
The InterVideo WinDVD Creator 
and RecordNow! recording programs support 
the double-layer technology.

Optical drive can
CD-

ROM
CD-
RW

DVD-
ROM

 DVD+
RW/+R

Double-
layer

Combo 
CD-RW/DVD

Read CDs, CD-Rs, and 
CD-RWs

Yes Yes Yes Yes Yes Yes

Read DVDs No No Yes Yes Yes Yes

Read data on a CD Yes Yes Yes Yes Yes Yes

Play music Yes Yes Yes Yes Yes Yes

Record data or music to 
disc for storage or 
backup

No Yes No Yes Yes Yes

View DVD movies No No Yes Yes Yes Yes

Record DVD movies No No No Yes Yes No

Play games Yes Yes Yes Yes Yes Yes
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Using the Software Quick Reference Table
To open software programs you can use with various 
media and an optical drive, click Start on the taskbar, 
choose All Programs, select the program folder, and 
then click the program to open the software. Refer to the 
following table to determine the best programs for the 
tasks you want to do.

Your HP Digital Entertainment Center comes with the 
following software programs. This is not a complete list of 
included software. Use this table to find out the programs 
that record and play CDs, record data CDs, and import, 
edit, and record video CDs and DVDs. Some programs 
listed below may not be included with your model.

Software With this program you can

iTunes ■ Play music CDs, MP3s, and other audio files.
■ Record music files.
■ Record a copy of an existing music or data CD to use on the HP Digital Entertainment 

Center.
■ Organize digital files into a library for recording or listening.

Windows 
Media Player

■ Play music CDs, MP3s, and other audio files.
■ Play DVD movies. (Windows Media Player can play DVDs only if another DVD player 

program, such as InterVideo WinDVD, is installed.)
■ Play Windows Movie Maker files.
■ Record music files.
■ Organize digital files into a library for recording or listening.

RealPlayer ■ Play music CDs, MP3s, and other audio files.
■ Play DVD movies. (RealPlayer can play DVDs only if another DVD player program, such as 

InterVideo WinDVD, is installed.)
■ Play video CDs.
■ Record music files.
■ Organize digital files into a library for recording or listening.
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Software With this program you can

Windows Movie 
Maker 2.0

■ Import audio, video, and other media files from a videotape, an audiotape, a Web 
camera, or a television broadcast.

■ Record audio and video files to create a video project that becomes a Windows Media 
source file with a .wmv extension.

■ Edit and preview files.
■ Send a movie in an e-mail or upload it to a Web server.
■ Add music files (MP3).
■ Import audio files such as .mp3, .asf, or .wma; video files such as .wmv, .asf, .avi, or .mpg; 

or image files such as .jpg or .gif.
■ Create .avi and .wmv (Windows Media Video) files.

InterVideo 
WinDVD

■ Play DVD movies and video CDs (VCDs).

RecordNow! ■ Record data and music files.
■ Record a copy of an existing music or data CD to use on the HP Digital Entertainment 

Center.
■ Create customized music CDs from CDs in your collection, or from .wav, .mp3, or .wma 

files. These CDs can be played in your home or car stereo.
■ Copy and share data files.
■ Capture (copy) short video files.
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Software With this program you can

InterVideo 
WinDVD 
Creator

■ Capture digital and analog video files directly from a digital video (DV) camera, VCR, or 
other analog capture device.

■ Assemble movies by capturing video clips and scenes into a video project.
■ Edit your movies. Cut scenes and add music and sound effects, still images, text, video 

transitions, and voice-overs.
■ Preview movies during editing and before recording final files.
■ Create video files, export them to your hard disk drive or your digital video camera, and 

then play them on your HP Digital Entertainment Center.
■ Create video files, record them to DVDs and CDs, and then play them on some set-top DVD 

players.
■ Record video files to 7 different formats.

muvee 
autoProducer 

■ Add your own style to your movies with music, pictures, titles, scene transitions, and 
captions.

■ Edit your home movies.

n
You may have a software update CD included 
with your HP Digital Entertainment Center. 
You may need to install this CD before using 
the DVD Writer/CD Writer drive. To do this, 
follow the installation instructions that 
came with the CD.

n
Video files recorded with RecordNow! can be 
viewed on your HP Digital Entertainment 
Center but not on home DVD video players.

n
The muvee autoProducer video editing 
program is for select models only.
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Your HP Digital Entertainment Center comes with one or 
two movie making programs, depending on your model. 
Both programs capture video, edit video, and help you 
add your own personal touch to your movies. You can 
capture, edit, and record your home movies in a few easy 
steps by using the InterVideo WinDVD Creator program 
located in your All Programs folder on your desktop. You 
can also use the muvee autoProducer program (select 
models only) to personalize your video files from within 
Media Center by using your remote control. See “Using 
muvee autoProducer” on page 111.

Both programs allow you to edit your video files and save 
your files to your hard disk drive. You need to use 
InterVideo WinDVD Creator to record your video file to a 
disc. If you use muvee autoProducer to create your video 
file, you can use WinDVD Creator to record it to disc.

Using WinDVD Creator
 InterVideo WinDVD Creator allows you to 
capture (copy), edit, and record your home 
movies in four easy steps.

Capture: Take videos and pictures from digital 
camcorders, analog video devices, and Web cameras, 
and then save them to your hard disk drive.

Edit: Arrange and trim your files. Add titles, transition 
effects, images, and audio.

Add Menu: Add a menu with chapters to your DVD.

Make Movie: Finalize your project by burning your 
movie to a DVD.

For more information about WinDVD Creator, click the 
Help menu in the WinDVD Creator menu bar.

n
You can use InterVideo WinDVD Creator to 
record your video files to disc. 
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Getting started

1 Using the trackball, click Start, choose All 
Programs, InterVideo WinDVD, InterVideo 
WinDVD Creator, and then click InterVideo 
WinDVD Creator again.

2 Select one of the menu options:

■ Start New Project: Opens the Edit section for 
you to begin creating a new project.

■ Open Existing Project: Opens the Open 
window for you to select an existing project.

■ Archive Video to DVD: Opens a wizard for 
you to bypass the hard disk drive and record 
directly from your camera to a recordable DVD 
or CD.

■ Edit Existing Video File: Opens the Import 
Media Files window for you to select an existing 
video clip.

■ Record to Video File: Opens the Capture 
section for you to capture media.

■ CD Labeling: Opens the InterVideo Disc Label 
program for you to design and create your own 
disc labels.

Identifying requirements for capturing video
You can capture (copy) video files to your hard disk drive 
by using the WinDVD Creator program. Among the 
devices supported by WinDVD Creator are analog video 
devices, digital camcorders, and Web cameras. Use your 
composite or S-video inputs to capture video from a VCR 
or an analog video camera.

To capture video files, you need to:

1 Connect your video source device properly.

2 Turn your device on and set it to playback mode.

3 Make sure WinDVD Creator can detect your digital 
or analog device.

4 If your HP Digital Entertainment Center has multiple 
video devices connected, they all appear on the 
Capture screen. You must select the video source you 
would like to use:

a In the WinDVD Creator Capture screen, click 
your input source.

b Click the Wrench icon.

c Select Device Control tab, and then select your 
video source from the Video Source drop-
down menu.

n
You may need to turn your digital video 
device off and on again for the program to 
detect it.
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Capturing digital camcorder video

1 Using the trackball, click Start, choose All 
Programs, InterVideo WinDVD, InterVideo 
WinDVD Creator, and then click InterVideo 
WinDVD Creator again.

2 Click the Record to Video File button.

3 Connect your digital camcorder to your HP Digital 
Entertainment Center.

4 Make sure the output from your digital camcorder 
appears in the Preview window. If it does not, 
double-check your connections and make sure your 
camera is in playback mode.

5 Click the Play button to preview your video file 
before you record it.

6 Find your starting point in the video, and click the 
Pause button.

7 Click the Record button.

8 Enter a file name, click Save, and recording begins.

9 Click the Stop button to stop capturing your video 
file. Your video file is processed and automatically 
saved to the My Videos folder on your hard disk 
drive. The video clip appears in the Media Library 
portion of the screen.

10 To play back your captured video, click the file in the 
Media Library, and click the Play button in the 
Preview window.

Capturing Web camera video

1 Using the trackball, click Start, choose All 
Programs, InterVideo WinDVD, InterVideo 
WinDVD Creator, and then click InterVideo 
WinDVD Creator again.

2 Click the Record to Video File button.

3 Connect your Web camera to your HP Digital 
Entertainment Center.

4 Make sure the output from your Web camera 
appears in the Preview window. If it does not, 
double-check your connections.

5 Click the Record button.

6 Enter a file name, click Save, and recording begins.

7 Click the Stop button to stop capturing your video 
file. Your video file is processed and automatically 
saved to the My Videos folder on your hard disk 
drive. The video clip appears in the Media Library 
portion of the screen.

8 To play back your captured video, click the file in the 
Media Library, and click the Play button in the 
Preview window.
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Capturing analog video

1 Click Start, choose All Programs, InterVideo 
WinDVD, InterVideo WinDVD Creator, and 
then click InterVideo WinDVD Creator again.

2 Click the Record to Video File button.

3 Connect your VCR, television, or other input device 
to your composite or S-video inputs.

4 Click your input source, click the Wrench icon and 
select the Device Control tab.

5 Select your composite or S-video source in the Video 
Source drop-down menu. Click OK.

6 Click the Record button.

7 Enter a file name, click Save, and recording begins.

8 Click the Stop button to stop capturing your video 
file. Your video file is processed and automatically 
saved to the My Videos folder on your hard disk 
drive. The video clip appears in the Media Library 
portion of the screen.

9 To play back your captured video, click the file in the 
Media Library, and click the Play button in the 
Preview window.

Capturing a still image

1 Pause your input device on the position for which 
you would like an image.

2 Click the Capture Still Image button under the 
Preview window.

3 The image is saved to the My Pictures folder on your 
hard disk drive.

Using the Preview window
The Preview window is located in the upper-left corner 
and behaves differently for each task.

Capture: Displays what your capture device is viewing.

Edit: Plays back the selected video or displays the 
selected image.

Add Menu: Displays what your menu and buttons 
look like.
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Using the Media Library
The Media Library contains your video clips, images, and 
audio tracks. To import existing media files from your 
hard disk or CDs into the Media Library, click the Drag 
and Drop button.

Capture: Located in bottom right corner. Contains your 
video clips, images, and audio tracks.

Edit: Located in upper-right corner. Contains your video 
clips, images, and audio tracks.

Add Menu: Located in upper-right corner. Contains 
menu themes, video backgrounds, audio tracks, images, 
buttons, chapter layouts, and chapter thumbnails.

Using the Storyboard
Located on the bottom of the Edit and Add Menu area, 
the Storyboard can be displayed in either Menu Picker or 
Timeline mode. Use the Storyboard to organize your 
media and add special effects such as titles, transition 
effects, audio tracks, and video filters.

Editing video files
After you capture video files, use the WinDVD Creator 
Edit module to create your customized video file. In the 
edit mode you can add:

■ Video files
■ Still images
■ Audio and music tracks

■ Transition effects
■ Video filters
■ Title effects

To edit your video files:

1 If your project is already open, click the Edit button 
and skip to step 4.

2 Click Start, choose All Programs, InterVideo 
WinDVD, InterVideo WinDVD Creator, and 
then click InterVideo WinDVD Creator again.

3 Open a project by selecting either the Start New 
Project or the Open Existing Project button.

4 If you have already captured video for this project, 
drag and drop the video files from the Media Library 
to the Storyboard. If you have video files on your 
hard disk drive you would like to add to this project, 
click the Drag and Drop button.

5 If you do not like the sequence of the video files, 
drag and drop the files in the Storyboard to change 
the sequence.
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Adding images

1 Click the Image Library icon.

2 Click the Drag and Drop button to open 
the My Pictures folder on your hard disk drive.

3 Select the images from your hard disk drive you 
would like to add to your Image Library, and 
click Open.

4 Drag and drop images from the Image Library to 
your Storyboard.

Now you can edit still images and video files. See the 
following table.

Storyboard icons

Group Groups multiple images into one on the Storyboard.

Expand Expands grouped images so they are all displayed on the Storyboard.

Save Movie
Records output directly to a DV camcorder or writes output to a file in your 
selected format.

Edit Clip Trims a video clip:

1 Double-click a video clip on the Storyboard.

2 Adjust the sliders to cut off video at the beginning or the end.

Merge Clip Merges a clip with the next clip.

Split Clip Splits a video clip:

1 Click the video clip you want to split.

2 Click the Play button in the Preview window.

3 Click the Split Clip icon at the point of the clip you want split.
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Adding audio effects

1 Click the Audio Library icon.

2 Click the Drag and Drop button to open 
the My Music folder on your hard disk drive.

3 Select the audio files from your hard disk drive you 
want to add to your audio library, and click Open.

4 Drag and drop the audio files from the Audio Library 
to the video file of your choice.

5 A musical note icon appears in the bottom right 
corner of the video file to which the audio track was 
assigned.

6 To keep the audio track running for more than one 
video file, switch from Storyboard mode to Timeline 
mode. Drag the music track across more than one 
video file.

Adding transition effects

1 Click the Transition Effects icon.

2 Drag and drop a transition effect between 
the two video files where you would like the 
effect to appear.

Adding title effects

1 Click the Title Effects icon.

2 Drag and drop a title effect either between 
video files or to a video file on the Storyboard.

3 Type the text you would like to appear on your title 
screen.

4 If you inserted the title effect between video clips, 
click the Image Setting icon to adjust the length of 
time you want the title clip to appear. 

A capital T appears in the bottom-right corner of the title 
clip on the Storyboard.
Creating Movies Using WinDVD Creator 107



Adding video filters

1 Click the Video Filters icon. 2 Drag and drop a video filter to the video of your 
choice.

Authoring your DVD
The Add Menu section makes your project interactive by 
creating a menu theme and by breaking it into chapters. 
The menu theme can be your own images and music or a 
custom theme that comes with WinDVD Creator.

1 If your project is already open, click the Add Menu 
button.

2 Click Start, choose All Programs, InterVideo 
WinDVD, InterVideo WinDVD Creator, and 
then click InterVideo WinDVD Creator again.

3 Select the Open existing project button, and then 
select your project.

4 Click the Add Menu button.

5 Click the Media Library icons to add a menu theme, 
chapters, buttons, audio tracks, and images to 
your DVD.

6 Click the Storyboard icons to edit the chapters and 
menu items.

Making a movie
This is the final step of your DVD project. You select a 
format, the type of TV system, and volume name.

1 If your project is already open, click the Make 
Movie button and skip to step 5.

2 Click Start, choose All Programs, InterVideo 
WinDVD, InterVideo WinDVD Creator, and 
then click InterVideo WinDVD Creator again.

3 Select the Open existing project button, and then 
select your project.

4 Click the Make Movie button.

5 Insert a blank recordable DVD or CD into your drive.
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6 Choose one from each of the following 
sections (order of selections may differ).

7 Click Start.

8 Click OK.

Select Function

Burn to Disc Use this to burn directly to a 
DVD or CD.

Write 
content to 
hard disk 
for later 
burning

Use this to create the file on 
your hard disk drive.

Select 
Device

Select the device that contains 
the blank recordable DVD 
or CD.

Burning 
Speed

Select the speed to use when 
recording your project.

Format Select one of the formats to 
record your project.

TV System Select between NTSC and 
PAL for your TV system. The 
NTSC format is used in North 
America, and the PAL format 
is used in European and Asian 
countries/regions.

Volume 
Name 
of Disc

Enter a Volume name for your 
disc (optional).
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Recording VHS files direct to DVD
To record VHS or other video files directly to DVDs:

1 Connect your VCR or other analog video source to 
your computer. See “Capturing analog video” on 
page 104 for more information about capturing 
analog video.

2 Click Start, choose All Programs, InterVideo 
WinDVD, InterVideo WinDVD Creator, and 
then click InterVideo WinDVD Creator again.

3 Select the Archive Video to DVD button and 
follow onscreen instructions.

Converting recorded TV to MPEG-2 format

1 If your project is already open, click the Edit button, 
and skip to step 4.

2 Using the trackball, click Start, choose All 
Programs, InterVideo WinDVD, InterVideo 
WinDVD Creator, and then click InterVideo 
WinDVD Creator again.

3 Open a project by selecting either the Start New 
Project or the Open Existing Project button.

4 Click the Save Movie icon, and select Output 
to File.

5 Select a GQ, HQ, SP, LP, or EP format, and 
click OK.

6 Enter a file name and click Save.

n
IMPORTANT: HP supports the lawful use of 
technology and does not endorse or 
encourage the use of our products for 
purposes other than those permitted by 
copyright law.
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Your HP Digital Entertainment Center comes with one or 
two movie making programs, depending on your model. 
Both programs capture video, edit video, and help you 
add your own personal touch to your movies. You can 
capture, edit, and record your home movies in a few easy 
steps by using the InterVideo WinDVD Creator program 
located in your All Programs folder on your desktop. See 
“Using WinDVD Creator” on page 101.

You can also use the muvee autoProducer program (select 
models only) to personalize your video files from within 
Media Center by using your remote control.

Both programs allow you to edit your video files and save 
your files to your hard disk drive. You need to use 
InterVideo WinDVD Creator to record your video file to a 
disc. If you use muvee autoProducer to create your video 
file, you can use WinDVD Creator to record it to disc. See 
“Recording a muvee autoProducer movie to disc with 
WinDVD Creator” on page 119.

Using muvee autoProducer
(Select models only)

Creating personalized and professional-looking 
video movies is simple with muvee 
autoProducer, a software program on your 
HP Digital Entertainment Center. You can 

access muvee autoProducer in Media Center under More 
Programs. 

The basic steps when using muvee autoProducer are: 

■ Capture digital video: Capture live or recorded 
video to your hard disk drive.

■ Add videos and pictures: Select video and 
pictures files on your HP Digital Entertainment 
Center. You can also capture (copy) videos directly 
from a compatible DV camcorder.

■ Add music: Select music files to add to your movie.

■ Select a style: Apply a movie style for a different 
effect and picture transition.

■ Add captions: Personalize your movie with 
opening titles and closing credits.

■ Make the movie: Automatically analyze the 
videos, pictures, music, movie style, and captions 
you added to your movie and save your movie to 
your HP Digital Entertainment Center.

For more information about muvee autoProducer, click the 
? in the muvee autoProducer menu bar.
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Getting started

1 Press the Media Center Start button  on the 
remote control to open Media Center.

2 Select More Programs, and then select the Make 
muvee icon.

3 Select one of the button options:

■ capture DV: Opens the Capture video from DV 
camcorder window for you to capture (copy) live 
video or recorded video.

■ video/pictures: Opens the Select Video 
window for you to select existing video files.

■ music: Opens the Add music files window for 
you to select existing music files.

■ style: Opens the Select Style window for you to 
select a style template for your movie.

■ add captions: Opens the Add Captions 
window for you to type in an opening title and 
closing credits for your movie.

■ make muvee: Opens the Make muvee 
window for you to set the duration of your movie 
and automatically create the movie.

■ save muvee: Opens the Save muvee window 
for you to save the finished movie to one of 
several formats.

Capturing video from a DV camcorder
You can capture (copy) digital video files to your hard 
disk drive by using muvee autoProducer with a 
compatible DV camcorder connected to a FireWire (IEEE 
1394) port on your HP Digital Entertainment Center. You 
can capture video either live (known as camera mode) or 
recorded (known as VCR mode).

Captured video files are automatically added to your 
movie project. To remove the file from your movie project, 
select the video file in the list of captured DV videos and 
then click Delete.

When capturing video, it is important to be aware of the 
amount of free space available on your HP Digital 
Entertainment Center hard disk drive. Capturing video 
can use a large amount of disk space. The amount of free 
disk space displays on the Capture Video window in 
muvee autoProducer while you are capturing video.
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Capturing live video from a DV camcorder
Capturing live video in camera mode allows you to 
create a video file without even having a tape in the 
camcorder.

To capture (copy) live video to your hard disk drive:

1 If your project is already open, click the capture 
DV button, and skip to step 4. 

2 Click Start, choose All Programs, muvee 
autoProducer, and then click muvee 
autoProducer again.

3 Open a new project by selecting from the File menu 
either New Project or Open Project.

4 Connect your DV camcorder to the FireWire (IEEE 
1394) port on your HP Digital Entertainment Center, 
and turn on the camcorder.

5 Set the camcorder to camera mode using the 
instructions in the manufacturer’s documentation.

6 Click the Start Capture button to begin capturing 
the live footage directly to your hard disk drive.

7 Click the Stop Capture button to stop capturing.

8 Click the Browse button to be able to specify a file 
name and folder for the captured video file.

Capturing recorded video from a DV camcorder
For best results with muvee autoProducer, capture only 
video footage that you are most interested in using in 
your movie project.

To capture (copy) live video to your hard disk drive:

1 If your project is already open, click the capture 
DV button, and skip to step 4. 

2 Click Start, choose All Programs, muvee 
autoProducer, and then click muvee 
autoProducer again.

3 Open a new project by selecting from the File menu 
either New Project or Open Project.

4 Connect your DV camcorder to the FireWire 
(IEEE 1394) port on your HP Digital Entertainment 
Center, and turn on the camcorder.

5 Set the camcorder to VCR mode using the instructions 
in the manufacturer’s documentation.

6 Click the Play button on the screen to begin viewing 
the video.

7 Click Start Capture when you see the start of the 
video footage you want to use in your movie project.

8 Click Stop Capture to stop capturing.

9 Repeat steps 7 and 8 to capture additional sections 
of video footage.

10 Click the Browse button to be able to specify a file 
name and folder for the captured video file.
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Selecting videos and pictures
It is easy to add video files and still images to your muvee 
production. The following formats are supported:

■ Video — .dv, .avi, .mpeg-1, .mpeg-2
■ Pictures — .bmp, .jpg, .jpeg, .gif

To add video and picture files:

1 If your project is already open, select the video/
pictures button and skip to step 4.

2 Click Start, choose All Programs, muvee 
autoProducer, and then click muvee 
autoProducer again.

3 Open a project by selecting from the File menu either 
New Project or Open Project, and then click the 
video/pictures button.

4 Click Add Video to select existing video files on 
your hard disk drive, if desired for your movie.

5 Click Add Picture to select still image files on your 
hard disk drive, if desired for your movie.

6 Adjust the order of the videos and pictures by 
selecting and then dragging and dropping the file or 
by using the Move Up and Move Down buttons.

7 Click OK when you are finished adding videos and 
pictures to your movie project.

Selecting music
You can use .mp3, .wav, or .wma formatted music files in 
your movie project.

You can also choose whether to use the original sound 
track from your video, blend the sound track with your 
music selections, or just use the selected music files.

To add music for your movie:

1 If your project is already open, click the music 
button, and skip to step 4.

2 Click Start, choose All Programs, muvee 
autoProducer, and then click muvee 
autoProducer again.

3 Open a project by selecting from the File menu either 
New Project or Open Project, and then click the 
music button.

4 Click Add Music to select existing video files on 
your hard disk drive, if desired for your movie.

n
Select multiple video or picture files by 
pressing and holding Ctrl on your keyboard 
while selecting the files.
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5 Adjust the order of the music by selecting and then 
dragging and dropping the file or by using the 
Move Up and Move Down buttons.

6 If a video file you are using features a sound track, 
use the Audio Mix slider to blend the sound track 
with your selected music files. The position of the 
slider determines how much of which music to use.

7 If you do not add any music files to your project, the 
original video sound track is automatically used.

8 Click OK when you are finished adding music to 
your movie project.

Setting the style
The muvee autoProducer program comes with a set of 
style templates for setting the pace, scene transition 
effects, and caption fonts. The style you use also affects 
how muvee autoProducer combines the video, picture, 
and music files in your movie project to produce the final 
movie.

For example, using the Cinema style results in a movie 
that is moderately paced, color enhanced, and uses a 
wide-screen format.

To select a style:

1 If your project is already open, click the style button 
and skip to step 4.

2 Click Start, choose All Programs, muvee 
autoProducer, and then click muvee 
autoProducer again.

3 Open a project by selecting from the File menu either 
New Project or Open Project, and then click the 
style button.

4 Select a style from the drop-down list. A description 
of the style displays in the upper part of the window 
along with a sample movie.

5 Put a check mark in the Keep shots in sequence box 
to maintain the original sequence of your video 
footage. Leave this box blank to allow muvee 
autoProducer to arrange the scenes to fit the style 
selected.

6 Click OK to close this window.

n
It is recommended to have at least twice the 
duration of video to the duration of music. 
For example, if you have 10 minutes of 
video, select 5 minutes of music.
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Adding captions
You can personalize your movie project by adding an 
opening title and closing credits.

1 If your project is already open, click the style button 
and skip to step 4.

2 Click Start, choose All Programs, muvee 
autoProducer, and then click muvee 
autoProducer again.

3 Open a project by selecting from the File menu either 
New Project or Open Project, and then click the 
style button.

4 Type in the text you want to appear at the start of 
your movie in the box under Opening titles.

5 Type the text you want to appear at the end of your 
movie in the box under Closing credits.

6 To set your own fonts for the opening title and closing 
credit, remove the check from the Let muvee 
autoProducer choose the fonts check box. 

7 Click the Font button next to the text you want to 
change.

8 Select the font, font size, color, and other text 
characteristics from the Font window.

9 Click OK.

10 Click OK to close the Add Captions window.

Making the movie
After you have added at least one video or picture file to 
your movie project, you can have muvee autoProducer 
make the movie.

The muvee autoProducer program makes a movie by 
combining the video, picture, and music files you have 
selected, along with the style of movie, and puts together 
all of these pieces into a professional-looking movie with 
just a few steps.

To make a movie:

1 If your project is already open, click the make 
muvee button and skip to step 4.

2 Click Start, choose All Programs, muvee 
autoProducer, and then click muvee 
autoProducer again.

3 Open a project by selecting Open Project from the 
File menu, and then click the make muvee button.

4 Select the duration for your movie by clicking either 
Automatic to allow muvee autoProducer to set the 
duration or Manual to allow you to set the duration.

n
The video quality of the preview may not be 
as smooth as the final saved version of your 
movie.
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5 If you select Manual, you can adjust the duration of 
the movie with the slider or the arrow controls for 
minutes and seconds.

6 If you select Manual and the duration of your music 
is longer than the duration of video and pictures, 
place a check in the Allow video segments to be 
repeated check box so that video and pictures can 
be repeated. This allows you to use the full duration 
of your music files.

7 If you select Manual and the total duration of your 
video and picture files is longer than the duration of 
your music, place a check in the Allow music clips to 
be repeated check box so that music can be used 
over again to fill the duration of the movie.

8 Click Continue to start the process of creating your 
movie.

Previewing your movie
After making a movie you can preview the movie in the 
muvee autoProducer Preview window. Use the controls in 
the Preview window to play, pause, and stop the movie 
preview.

Each time you make a change to a movie project, you 
need to click the make muvee button again to add that 
change to your movie.

You can revise and preview the movie as often as you 
want to experiment with different styles and the content of 
the movie.

Saving the movie project
Once you are satisfied with the look of your movie 
project, you are ready to save it.

You can save the movie to a file on your hard disk drive 
or create a VCD or DVD disc.

1 Open your movie project, and click the save 
muvee button.

2 Choose a file type to save the movie to your hard 
disk drive:

■ WMV-Small File
■ WMV-High Quality
■ MPEG1/VCD
■ MPEG2/DVD

Or

Choose a format to save your movie to a disc:

■ VCD
■ DVD
Creating Movies Using muvee autoProducer 117



Selecting video scenes with magicMoments
You can mark specific scenes in your video footage to 
include or leave out of your final movie with the 
magicMoments feature in muvee autoProducer.

Video footage left unmarked is still analyzed when you 
make the movie and may be included in the final version 
of the movie.

Using the magicMoment controls
The magicMoments window uses the following controls: ■ The green thumbs-up button is for marking scenes 

that must be included in the movie.
■ The red thumbs-down button is for marking scenes 

that must be left out of the movie.
■ The gray thumb button is for undoing scenes that 

were marked with the thumbs-up or thumbs-down 
buttons.

■ The arrow buttons are for navigating backward and 
forward through the video footage.

Using magicMoments to select video scenes
For best results with the production of your movie:

■ Keep the total duration of magicMoments to less than 
50 percent of the duration of your movie. It is 
recommended to select only a few scenes.

■ Make sure magicMoments do not cross scenes. This 
can result in poor scene transition appearance.

■ Keep each magicMoment to less than 10 seconds. 
To select video scenes with magicMoments:

1 If your project is already open, select the video/
pictures button and skip to step 5.

2 Click Start, choose All Programs, muvee 
autoProducer, and then click muvee 
autoProducer again.

3 Open a project by selecting from Open Project, 
from the File menu.

4 Select a video file, and then click Open. 

5 Click the video/pictures button.

6 Select a video file in the Select Video/Pictures 
window, and then click the magicMoments 
button.

7 Click the Play button to start viewing the video and 
use the magicMoment controls to mark scenes to 
include and exclude.

8 Click OK when you finish marking scenes.

9 Click OK to close the Select Video/Pictures window.
118 Microsoft Windows XP Media Center Edition 2005 Software Guide



C
re

a
ti
n
g
 M

o
vi

es
 U

si
n
g
 

m
u
ve

e 
a
u
to

P
ro

d
u
ce

r

Recording a muvee autoProducer movie 
to disc with WinDVD Creator
To create a VCD or DVD disc.

1 Using the trackball, click Start, choose All 
Programs, InterVideo WinDVD, InterVideo 
WinDVD Creator, and then click InterVideo 
WinDVD Creator again.

2 Select Create CD/DVD with existing 
video file.

3 Select your video file you created in muvee 
autoProducer, and then click Open.

4 Click the Make Movie tab, select Burn to Disc, 
and then select the arrow button to begin burning 
your movie to disc.

5 Follow the onscreen instructions.
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The HP Personal Media Drive is included with some 
HP Digital Entertainment Center models and it is sold 
separately. It can be used as an internal or external USB 
hard disk drive designed to quickly and easily increase 
your storage capacity and to transfer media files such 
as digital photos, music, videos, and other important 
files from one PC to another. You can also use the 
HP Personal Media Drive to back up other drives on 
your HP Digital Entertainment Center.

The HP Personal Media drive is designed to:

■ Work with the HP Digital Entertainment Center and 
other PCs that have a USB port.

■ Store large media files and personal files.
■ Transfer files between PCs.
■ Play media files.
■ Back up your files.

For more information about using your HP Personal 
Media Drive with Media Center, refer to the 
documentation on the HP Support Web site at:

http://www.hp.com/support

n
The HP Personal Media Drive is included with 
some HP Digital Entertainment Center models 
and it is sold separately.
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Setting Up the HP Personal Media Drive to 
Work with Media Center
When you complete this setup procedure, you are able to 
easily access content — such as music, photos, videos, 
and recorded TV programs — from customized folders on 
your HP Personal Media Drive.

Once you complete the HP PMD (Personal Media Drive) 
setup wizard, you can drag and drop your music, video, 
pictures, and recorded TV files from your primary hard 
disk drive to personalized folders in the HP Personal 
Media Drive for backup or storage. You can also use your 
remote control to access these files from within Media 
Center.

1 Press the Media Center Start button  on the 
remote control.

2 Use the arrow buttons on the remote control to select 
More Programs, and then press OK on the remote 
control.

3 Select HP PMD Setup, and then press OK on the 
remote control.

4 Follow the onscreen instructions to complete the setup 
wizard.

5 Restart the HP Digital Entertainment Center.

Locating the Drive After Installation
After you install the HP Personal Media Drive into the HP 
Digital Entertainment Center, you can find the drive in My 
Computer. The HP Digital Entertainment Center 
automatically assigns a drive letter which may change 
unless you assign a drive letter. See “Assigning a Drive 
Letter to the HP Personal Media Drive” on page 123.

1 Click Start on the taskbar.

2 Click My Computer.

3 Select your drive under Hard Disk Drives. The default 
name is HP Personal Media Drive.

n
The HP PMD setup wizard in More Programs 
allows you to set up folders so that you can 
more easily access your media files with 
Media Center.
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Assigning a Drive Letter to the HP Personal 
Media Drive
You can permanently assign a drive letter to avoid the 
letter changing when you connect and disconnect this 
drive and other devices. Also, it is easier for a software 
program to locate files on the HP Personal Media Drive if 
a drive letter is assigned. Some programs may not be 
able to find files if the drive changes letters every time you 
connect it.

To assign a drive letter:

1 Click Start.

2 Right-click My Computer.

3 Select Manage, and then click Disk 
Management.

4 Right-click HP Personal Media Drive.

5 Select Change Drive Letter and Paths. HP 
recommends that you pick the drive letter Z.

6 Click Change and select a letter, and then apply the 
changes by clicking OK.

Viewing and Storing Files
The recommended way to transfer files to the HP Personal 
Media Drive is to drag them from your local hard disk 
drive to your HP Personal Media Drive.

If you want the files that are stored on your HP Personal 
Media Drive to appear in Media Center, you must drag 
them to the correct media folders, such as My Personal 

Videos and My Personal Pictures on your HP Personal 
Media Drive. These media folders appear after you 
complete the PMD setup wizard. See “Setting Up the HP 
Personal Media Drive to Work with Media Center” on 
page 122.

n
To avoid multiple hard disk drives using the 
same drive letter when connecting and 
removing the drives, assign the letter Z.
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Playing Media Files
You can play all kinds of media from an HP Personal 
Media Drive:

1 Click Start on the taskbar.

2 Click My Computer.

3 Double-click the HP Personal Media Drive icon 
to locate your media file.

4 Double-click the file. Most media files open in 
Windows Media Player.

Playing Music Files
You can play all kinds of music stored on the HP Personal 
Media Drive. If you want the music files that are stored on 
your HP Personal Media Drive to appear in the Media 
Center My Music window, you must complete the PMD 
wizard in the More Programs area of Media Center. See 
“Setting Up the HP Personal Media Drive to Work with 
Media Center” on page 122.

When you disconnect the drive, your music files may still 
appear in the Windows Media Player Library and Media 
Center My Music window. To refresh your HP Digital 
Entertainment Center, open and close Windows Media 
Player or Media Center. If that doesn’t work, restart the 
HP Digital Entertainment Center.

Viewing Picture Files
You can view your pictures stored on an HP Personal 
Media Drive. If you want the picture files that are stored 
on your HP Personal Media Drive to appear in the Media 
Center My Pictures window, you must complete the PMD 
wizard in the More Programs area of Media Center.
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Playing Video Files
You can view your videos stored on an HP Personal 
Media Drive. If you want the video files that are stored on 
your HP Personal Media Drive to appear in the Media 
Center My Videos window, you must complete the PMD 
wizard in the More Programs area of Media Center. See 
“Setting Up the HP Personal Media Drive to Work with 
Media Center” on page 122.

When you disconnect the drive, your video files may still 
appear in the Media Center My Videos window. To 
refresh your HP Digital Entertainment Center, open and 
close Media Center.

Watching TV Programs Stored on the 
HP Personal Media Drive
To play back recorded TV files stored on your HP Personal 
Media Drive, you must:

1 Connect your HP Personal Media Drive to the 
HP Digital Entertainment Center with the power 
turned off.

2 Turn on the HP Digital Entertainment Center and 
open Media Center.

3 Click Settings, TV, Recorder, Recorder 
storage.

4 Under Record on drive select the HP Personal 
Media Drive, select Save, and then select Yes. A 
Recorded TV folder is created and placed in your 
HP Personal Media Drive. Recorded TV shows must 
be placed in this folder to access them with Media 
Center.

5 Under Record on drive, select your local hard disk 
drive, select Save, and then select Yes.

6 Move or copy your recorded TV programs to the 
Recorded TV folder on your HP Personal Media 
Drive. Now you can view your stored TV programs 
in Media Center, or you can double-click the file and 
view the show in Windows Media Player.

7 Close Media Center before disconnecting the drive.

When you connect your drive, stored TV files appear a 
few seconds after you open Media Center.

PV

n
You need to close Media Center before 
removing or before connecting your 
HP Personal Media Drive for the stored TV 
files to update properly.
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About Recording TV to the HP Personal 
Media Drive
The HP Digital Entertainment Center was set up to record 
TV shows to your local hard disk drive when using Media 
Center. It is possible to change the recording pathway to 
an HP Personal Media Drive, but several errors can occur 
if the drive is unexpectedly or improperly removed.

It is recommended that you record TV shows to your local 
hard disk drive and then copy the files over to your 
HP Personal Media Drive.

If you decide to change your recording path to the 
HP Personal Media Drive, consider the following:

■ The TV recording path does not default back to your 
local hard disk drive after the HP Personal Media 
drive is disconnected. This means scheduled 
recordings may not be recorded. The recording error 
Low Disk Space may occur, and then your program 
will not be recorded. See “Changing Disk 
Allocation” on page 129 for more information about 
fixing this error.

■ When the drive is disconnected, the disk allocation 
for Recorded TV shows reverts to 10%, and your 
recorded programs can be lost if you have selected 
the “Keep until space is needed” setting in My TV. 
See “Changing Disk Allocation” on page 129 for 
more information about changing the allocation.

■ If you disconnect the drive while Live TV is active, a 
video error can occur.

■ Recorded TV shows are not updated in Media Center 
when the drive is removed.

■ The drive may be assigned a different drive letter 
which prevents Media Center from recognizing the 
recording path or the stored Recorded TV files.

When you set the TV recording pathway to your 
HP Personal Media Drive, Media Center stores the 
recording buffer data for pausing live TV on your drive. 
This means that if live TV is playing, you won’t be able to 
remove the drive safely.

To avoid this scenario, change the recording pathway 
back to your local hard disk drive, and then restart the 
HP Digital Entertainment Center before disconnecting the 
HP Personal Media Drive.

n
■ HP recommends that you record TV 

programs directly to your local hard disk 
drive and then transfer the programs to the 
HP Personal Media Drive.

■ If you have problems recording after you 
have changed the recording pathway, close 
Media Center and then open it, and then 
restart the HP Digital Entertainment Center.
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Recording TV programs to the HP Personal Media Drive

1 Change your recording pathway to your HP Personal 
Media Drive. See “Changing the TV recording path 
to the HP Personal Media Drive” on page 127.

2 Open Media Center.

3 Record TV programs. See “Recording TV from the 
Guide” on page 31. Your programs are recorded to 
the HP Personal Media Drive.

4 Before disconnecting the drive:

■ Make sure there are no scheduled recordings or 
recordings in progress to avoid losing data.

■ Change the recording pathway back to your 
local hard disk drive. See “Changing the TV 
recording path to the local hard disk drive” on 
page 128.

5 Close Media Center.

6 Restart your HP Digital Entertainment Center. You 
must perform this last step, or errors can result when 
recording to your drive.

7 Disconnect your HP Personal Media Drive safely. See 
“Disconnecting the HP Personal Media Drive Safely” 
on page 128.

Changing the TV recording path to the 
HP Personal Media Drive
If you decide to change your recording path to record 
directly to your HP Personal Media Drive, Media Center 
creates a Recorded TV folder on your drive.

1 Assign a drive letter to your HP Personal Media 
Drive. See “Assigning a Drive Letter to the HP 
Personal Media Drive” on page 123.

2 Open Media Center.

3 Select Settings, TV, Recorder, and then 
Recorder storage.

4 Under Record on Drive, select (+) to select the 
HP Personal Media Drive. You can also set the 
disk allocation and recording quality settings in this 
window.

HP recommends that you know the drive letter 
assigned and the storage amount of your 
HP Personal Media Drive.

5 Click Save, and then click Yes.

6 Close Media Center.

7 Restart the HP Digital Entertainment Center.

To change the TV recording path back to your local hard 
disk drive, follow this procedure and select your hard disk 
drive in step 4.

n
HP recommends that you record TV programs 
directly to your local hard disk drive and then 
transfer your recorded programs to the 
HP Personal Media Drive, if desired.
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Changing the TV recording path to the local hard disk drive
To change the Media Center TV recording path to your 
local hard disk drive:

1 Open Media Center.

2 Select Settings, TV, Recorder, and then 
Recorder storage. You can also set the disk 
allocation and recording quality settings in this 
window.

3 Select your local hard disk drive (C:).

4 Click Save, and then click Yes.

5 Close Media Center.

6 Restart the HP Digital Entertainment Center.

Disconnecting the HP Personal Media Drive 
Safely
You can safely remove the drive when it is not active. 
When the amber activity light is blinking, the drive is 
active, saving or transferring data. Removing the drive 
while the light is blinking may cause data loss or 
damaged files.

To disconnect your HP Personal Drive safely:

1 Close Media Center and all other programs that may 
be accessing your HP Personal Media Drive. Make 
sure the activity LED is off.

2 Double-click the Safely Remove 
Hardware icon in the system tray at the 
bottom of the desktop. If this icon is hidden, 
click the arrows on the taskbar to display it. The 
Safely Remove Hardware window opens.

3 Double-click USB Mass Storage Device to locate 
your HP Personal Media Drive. USB Mass Storage 
Device may be listed twice. One may contain a 
memory card reader or other mass storage drives.

4 Select your device that is labeled HP Personal Media 
Drive, and then click OK. This name of the drive may 
appear as Generic Volume followed by the assigned 
drive letter. A Safe to Remove Hardware message 
appears in the system tray at the bottom of your 
desktop letting you know that your drive is safe to 
disconnect.

5 Click Close.

6 Disconnect the drive from the HP Digital 
Entertainment Center.
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Changing Disk Allocation
If you experience a Low Disk Space error message, and 
you want to change the disk allocation to a higher 
percentage for your HP Personal Media Drive:

1 Open Media Center.

2 Select Settings, TV, Recorder, and then select 
Recorder storage.

3 Change the disk allocation percentage setting by 
selecting the (+) or (–) option.

Updating Recorded TV List after Removing 
the HP Personal Media Drive
If you want to update your Recorded TV list after 
removing the drive:

1 Close Media Center.

2 Open Media Center.

3 If this does not update the files, restart the HP Digital 
Entertainment Center.
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System Requirements to View Recorded 
TV Programs on Other PCs
To play back recorded TV files (.dvr-ms files) that were 
recorded on your HP Digital Entertainment Center on 
another non-Media Center PC, the PC must have the 
following items installed:

■ Windows XP operating system 
■ Windows XP Service Pack 1
■ Windows Media Player 9 or later
■ Software to play DVDs
■ The audio and video codec file allows Windows 

Media Player to play recorded TV programs (.dvr-ms 
files). You can find this file in Windows Update. Click 
Start, choose All Programs, and then click 
Windows Update. You can also go to the 
Windows Web site and search for this code file 
(Q810243).

If you want more information about this file you can go to 
the Microsoft Web site at:

http://www.microsoft.com

n
Some recorded TV programs with the 
broadcast flag turned on are copy protected 
and cannot be viewed on other PCs.
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